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Introduction

SAMACP16C-EK is an evaluation kit of the G3-PLC for Power Line Communication from Atmel®
Corporation. The Atmel® | SMART SAM4CP16C has a flexible architecture, composed of hardware
accelerators and coprocessors, achieves a very efficient G3-PLC implementation.

SAM4CP16CMB is PLC multi-purpose modem board based on the SAMACP16C device. This
development board provides a full featured platform to develop a complete communications system over
Power Line Communication technology.

SAMACP16C is based on Atmel | SMART SAM4C, a high performance 32-bit, dual core ARM® Cortex®
M4 RISC processor embedding a G3 PLC modem. The two cores Cortex-M4 are able to operate at a
maximum speed of 120 MHz, featuring 1 Mbyte of embedded Flash, 128 Kbytes of SRAM and on chip
cache for each core. The peripheral set includes advanced cryptographic engine, anti-tamper, floating
point unit (FPU), 5x USARTSs, 2x UARTSs, 2x TWIs, 6 x SPI, as well as 1 PWM timer, 2x three channel
general-purpose 16-bit timers, integrated true RTC, a 10-bit ADC, and a 46 x 5 Segmented LCD
controller.

This guide describes how to use the kit and get start with it.

Contents
e Welcome letter that presents you the e Cables:
evaluation kit and the contents. «  Two micro A/B-type USB cables.
* Boards: e  Two power cord cables IEC320-
e Two SAM4CP16CMBv1 modem cs.
boards. _ e Jumpers:
¢ Two ATPLCOUPOO7v2  coupling e Two voltage jumpers with pitch
boards. 508 mm
e Two ATPLCOUPO06v1 coupling « Two erase jumpers with pitch
boards. 254 mm
Features

e SAM4CP16C is a flexible, compact and high-efficient device for a wide range of Smart Grid
applications such as Smart Metering (Smart Meters and Data Concentrators), Lighting,
Industrial/Home Automation, Home and Building Energy Management Systems, Solar Energy and
Plug-in Hybrid Electric Vehicle (PHEV) Charging Stations.

e SAM4CP16CMB modem board mounts the Atmel | SMART SAM4CP16C 32-bit ARM Cortex M4
microcontroller. This development board provides a full featured platform to develop a complete
communications system over Power Line Communication technology.

e Evaluation platform performance for the SAM4CP16C to develop a complete communications
system based on PLC technology:

— Channel characterization.

— Noise level measurement.

— Sensitivity level measurement.
— Maximum reachable distance.
— Power consumption.
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— Possibility to verify the different standard frequency bands complying with the existing
regulations (CENELEC, FCC, ARIB) setting the different PLC couplings boards.

— Atransformer lets you supplied the board with universal 100-230 Vac 50-60 Hz power input.

— Boards have a JTAG interface for debugging and programming purposes and two
debugging UARTs. And also it provides Battery Backup and slow crystal oscillator to
support the embedded Real Time Clock (RTC) and low power modes. Several wake up
conditions are available, such mains crossover detection and voltage rails recovery
condition.

e  Software application examples available based on G3-PLC Stack:

— Atmel provides an Atmel G3-PLC PHY layer library with three example projects that lets
you know how to use it.

— And also the MAC and ADP layer to complete the Atmel G3-PLC Stack with two
applications.
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1. Evaluation Kit Specifications

1.1  Safety recommendations

These development boards must be only used by expert technicians. SAM4CP16CMB is directly
powered from mains grid, so hazardous voltage (100/230Vac) is present on the board. To avoid user
access to dangerous parts, SAM4CP16CMB must always be used within its enclosure. All required
connectors and configuration jumpers are easily accessible without electrical shock risk.

9 IMPORTANT A normal use of SAMACP16CMB does not require removing the
enclosure cover. If this action is necessary, it must be performed by

qualified staff after being sure that mains connection has been

previously removed. Be careful because it is only for indoor use.

This development board does not have any switch on mains connection to switch on or off it. It must
always be connected to an easy accessible mains socket.

Do not connect any probe to high voltage sections if the board is not isolated from the mains supply to
avoid damaging of measurement instruments.

This board can be used with coin lithium batteries, which are highly contaminated products. Used
batteries must always be recycled.

A WARNING The boards’ kits are shipped in a protective anti-static package. The
board system must not be subjected to high electrostatic discharge.

We strongly recommend using a grounding strap or similar ESD

protective device when handling the board in hostile ESD environments

(offices with synthetic carpet, for example) without enclosure. Avoid

touching the component pins or any other metallic element on the
board.

SAM4CP16CMB is a CE mark product which passes EN60950-1 safety standard and EN50065-1,
EN50065-2-3, EN600065-7 EMC standards. It also satisfies Pb-Free and ROHS directive.

A WARNING ATMEL does not assume responsibility for the consequences arising
from any improper use of this board.

Boards’ kits are intended for further engineering, development, demonstration, or evaluation purposes
only. It is not a finished product except as may be otherwise noted on the board/kit.

1.2 Electrical characteristics

This section shows the electrical characteristics of the kit's boards. See the following tables:

Table 1-1. Power Supply Requirements.

I T T S T

AC mains Voltage Range

Mains Frequency 50/60 Hz

Maximum Input Current 200M mA

ACDC power supply and

PLC coupling transformer Ehu e

Isolation Voltage
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Note that the SAM4CP16CMB can be supplied either with 100Vac or 230Vac by setting the proper
jumpers (pitch = 5.08mm) in the voltage selector, J2, as depicted in the Figure 6-22. By default, voltage
jumper is set for 230Vac. For more information about power supply, see section 3.5.1.

Notes: 1. This current is measured when board is supplied with 100Vac and board is in worst

consumption conditions. That is when it emits against very low impedance in higher channel
and it is supplying an extra board through the DC jack J15.

Table 1-2.  Power Consumption.

I N S 2 R

ACDC maximum output

Max Power Consumption
power

FW PHY Tester Tool App.
Low Impedance Load
(PRIME LISN). 22320 44400 mw
Measured on Vop (12V)
DCDC output.

TX Power Consumption
FW PHY Tester Tool App.

High Impedance Load
(CISPR LISN). 13440 1800 @ mwW
Measured on Vop (12V)
DCDC output.

Measured on 3.3V LDO

384@ mw
output

RX Power Consumption

Low Power Mode Current

)
Consumption <1 WA

Notes: 1. These measurements were taken with a non-optimized FW (with the PHY TX Test Console
project included in the kit using a default configuration in RX mode and a differential robust
modulation scheme and data random with a length of 100 bytes of payload in TX mode)
from a power consumption point of view and they highly depend on the architecture of the
power supplies. These measurements correspond to the whole PCBA design and not only
to SAM4CP16C device. All PCB peripherals are supplied, i.e. LCD display and
ATPLCOUPOQO07 coupling board is emitting in channel 1. Refer to Atmel SAM4CP16C
datasheet for an optimized power consumption measurement result.

2. Output current of a 3V CR1225 battery.
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2. Evaluation Kit Overview

SAMA4CP16C is a Flash microcontroller based on a dual high performance 32-bit ARM Cortex-M4 RISC
processor embedding a G3-PLC transceiver for Power Line Communication that implements G3
CENELEC-A, FCC and ARIB profiles.

SAM4CP16C is oriented to a wide range of Smart Grid applications such as Smart Metering, Lighting,
Industrial/Home Automation, Home and Building Energy Management Systems, Solar Energy and Plug-
in Hybrid Electric Vehicle Charging Stations.

SAM4CP16CMB is PLC multi-purpose modem board based on the SAM4CP16C microcontroller. This
development board provides a full featured platform to develop a complete communications system over
Power Line Communication technology.

This document describes how to starting to work with the Atmel Evaluation Kit, SAM4CP16C-EK, by
explaining the PC tools, software examples and hardware provided and giving you the necessary
documents to create your PLC application by means of small and easy examples.

2.1  Design support

To make it faster and easier for you to evaluate, prototype, develop and program with Atmel® products,
we offer a variety of design resources, including development tools, software, boards, kits and
documentation.

For any technical support request, please refer to our Design Support webpage:
http://www.atmel.com/design-support/.

There any user can search the Atmel knowledge base to find tips, help topics, and answers to common
guestions. In case that the obtained information is not helpful any user can Open a Support Case
indicating a description of the case, product information, etc.

2.2  SAMA4CP16C-EK contents

Additional information of this user guide as hardware documentation, software projects and PC tools to
get started can be found in our Atmel website, http://www.atmel.com/tools/ATSAM4CP16C-EK.aspx. To
download this information you need a myAtmel account, www.atmel.com/myAtmel. After that, please
contact with plc@atmel.com to get the password access kit contents site. Once you have access to the
ATSAMA4CP16C Evaluation Kit you can find the available releases for the SAM4CP16C-EK. You can
get these items, navigating through the different folders of the packing kit. Please do not hesitate to
visit our web site to get the last kit updates.

Packing kit contents are:

1. A welcome letter, ATSAM4CP16C-EK_WL, which presents you the evaluation kit and the con-
tents.
2. SAMA4CP16C-EK Kit User Manual, doc43086.
3. Hardware folder contents:
a. SAMA4CP16C datasheet, doc43080.
b. Some application notes about hardware issues: different Atmel PLC coupling boards,
crystal selection guidelines, layout recommendations, critical design guidelines, etc.
c. Schemes, PCBs layout, Gerbers and BOM files of SAM4CP16CMB, ATPLCOUPO007 and
ATPLCOUPOO06 boards.
4. Software folder contents:
a. G3 va.b.c_CENELEC folder which contains five projects for IAR and Atmel Studio in an

unigue  workspace to  work in CENELEC-A  frequency  band, see
g3.workspace.sam4cpl6c_sam4cplécmb.zip file:
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e Apps_Phy Tester_Tool. This application configures G3 PHY layer and its serial
interface to communicate with Atmel PLC PHY Tester Tool to send and receive PLC
messages from/to the PLC line and check the PLC transmission/reception processes
between SAM4CP16CMB boards.

e Apps_Phy Tx Test _Console. This application lets the user to configure a proper set
up to perform both EMC emissions and immunity tests on SAM4CP16CMB board.
These tests are based on the use of G3 PHY layer with a terminal console firmware
that eases the configuration of several transmissions.

e Apps_Phy_ Sniffer_Tool. This application configures G3 PHY layer to monitor the PLC
data traffic on SAM4CP16CMB boards and sends via serial communication this traffic
to the ATPL Multiprotocol Sniffer tool. Every coupling board is intended to be used in
their corresponding channel(s) only.

e APPS_DLMS_EMU_COORD_APP and APPS_DLMS_EMU_DEV_APP. The DLMS
Emulator applications are examples using the Atmel G3-PLC stack and show how
the G3 API should be used. These applications are provided for both, Device and
Coordinator. Applications configure the SAM4CP16CMB board as Nodes with DLMS
Emulation capabilities and simulate the data exchange between the G3 Coordinator
and the Device(s). The Device responds dummy DLMS messages after receiving
data requests from the Coordinator.

b. G3 va.b.c_FCC folder which contains five projects for IAR and Atmel Studio in an unique
workspace to work in FCC bands frequency, see
g3.workspace.sam4cpl6c_samdcpl6écmb.zip file:

e Apps_Phy Tester_Tool. This application configures G3 PHY layer and its serial
interface to communicate with Atmel PLC PHY Tester Tool to send and receive PLC
messages from/to the PLC line and check the PLC transmission/reception processes
between SAM4CP16CMB boards.

e Apps_Phy Tx_Test_Console. This application lets the user to configure a proper set
up to perform both EMC emissions and immunity tests on SAM4CP16CMB board.
These tests are based on the use of G3 PHY layer with a terminal console firmware
that eases the configuration of several transmissions.

e Apps_Phy_Sniffer_Tool. This application configures G3 PHY layer to monitor the PLC
data traffic on SAM4CP16CMB boards and sends via serial communication this traffic
to the ATPL Multiprotocol Sniffer tool. Every coupling board is intended to be used in
their corresponding channel(s) only.

e APPS DLMS EMU_COORD_APP and APPS_DLMS _EMU_DEV_APP. The DLMS
Emulator applications are examples using the Atmel G3-PLC stack and show how
the G3 API should be used. These applications are provided for both, Device and
Coordinator. Applications configure the SAM4CP16CMB board as Nodes with DLMS
Emulation capabilities and simulate the data exchange between the G3 Coordinator
and the Device(s). The Device responds dummy DLMS messages after receiving
data requests from the Coordinator.

c. Compiled patches for the SAM4CP16C in both IDE tools (Atmel Studio and IAR).

d. Common software documentation folder. It contains some application notes as the
description of the Atmel G3 firmware stack. It describes in detail all layers from the Atmel
G3 implementation as well as configuration options provided by Atmel.

e. Evaluation License Agreement document.

5. PCTools folder contents:

a. Atmel PLC PHY Tester tool, for checking the point to point PLC transmissions between
SAM4CP16CMB boards.
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b. ATPL Multiprotocol Sniffer tool to monitor data traffic on G3 networks and gather information
of a G3 network.

c. SAM-ICE™ Drivers. Users may need to install this driver the first time the SAM-ICE is
connected to the PC.

d. USB Drivers (Silicom usb drivers). Users may need to install these drivers the first time the
SAM4CP16CMB board is connected to the host PC by means of a serial USB connection.

’ We recommend installing the evaluation kit contents in the root C:\ to avoid problems with
very long paths.

Unpack and inspect the kit carefully. Contact your local Atmel distributor, should you have any issues
concerning the contents of the kit.

The two SAM4CP16CMB boards with the ATPLCOUPOQ7 are encapsulated with enclosures and
shipped in protective anti-static foam. The two coupling boards, ATPLCOUPO0O06, are shipped in shielded
bags.

The boards must not be subject to high electrostatic discharge. We recommend using a
grounding strap or similar ESD protective device when handling the board in hostile ESD
environments. Avoid touching the components pins or any other metallic elements on the
board.

Note that kit does not provide any battery. The coin battery is provided for user convenience in case the
user would like to exercise the date and time backup function of the SAM4CP16C device when the
board is switched off.

Figure 2-1. Packed Atmel SAM4CP16C-EK.
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Figure 2-2. Unpacked Atmel SAM4CP16C Evaluation Kit.

o

»

Both SAM4CP16CMB boards are provided with an example application preprogrammed, the PHY
Tester embedded software. After installing the Atmel PLC PHY Tester Tool in your PC, users can
interface with the device and start exploring its capabilities, for example, checking the point to point PLC
transmissions between the two SAM4CP16CMB boards.

Take into account that the SAM4CP16C-EK provides two coupling boards for CENELEC-A band set
over the SAM4CP16CMB board. In addition to the ATPLCOUPOQOQ7 boards, evaluation kit adds two
coupling boards for FCC bands.

Atmel PLC PHY Tester Tool lets you send and receive PLC messages with both coupling boards
according to the board selected in the PC tool. And depending on the board selected you will select the

Atmel SAMACP16C-EK Kit User Manual [USER GUIDE] 11

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015



PHY parameters and the PLC channel. So that, with ATPLCOUPO007 board only lets you send and
receive PLC messages in CENELEC-A band. And with ATPLCOUPO006 board in FCC bands. Please
refer to chapter 6.2 for further information.

Figure 2-4. ATPLCOUPO007v2 board (CENELEC-A band frequency).

TG‘N[?@‘@ R12) D

4
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3. SAM4CP16CMB Hardware

3.1 Overview

This section summarizes the Atmel SAM4CP16CMB board design. It introduces system-level concepts,
such as power supply, SoC, PLC coupling, peripherals and interface board.

SAM4CP16CMB is a G3 multi-purpose development board based on the SAM4CP16C ARM Cortex-M4
microcontroller which incorporates a G3-PLC peripheral. SAM4CP16CMB modem board provides a
platform to develop a complete communications system over G3-PLC technology.

Figure 3-1. SAM4CP16CMB board.

3.2 Features
The SAM4CP16CMBV1 board includes the following features:

e  Power supply:
— Non switched ACDC isolated power supply: 100-230Vac, 50-60Hz.
— 5volts rail is accessible by means of a DC Jack connector (J15).
e SAMA4CP16C:
— Application/Master Core (CM4PO0):
e ARM Cortex-M4 running at up to 120 MHz.
e Memory Protection Unit (MPU).
e DSP Instruction.
e Thumb®-2 instruction set.
e Instruction and Data Cache Controller with 2 Kbytes Cache Memory.
e Memories:
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— 1024 Kbytes of Embedded Flash for Program Code (I-Code bus) and Program
Data (D-Code bus) with Built-in ECC (2-bit error detection and 1-bit correction
per 128 hits).

— 128 Kbytes of Embedded SRAM (SRAMO) for Program Data (System bus).

— 8 Khytes of ROM with embedded boot loader routines (UART) and In-
Application Programming (IAP) routines.

— Co-processor (CM4P1), provides ability to separate application, communication or
metrology functions:

e ARM Cortex-M4F running at up to 120 MHz.

e |EEE® 754 Compliant, Single precision Floating-Point Unit (FPU).

e DSP Instruction set.

e Instruction and Data Cache Controller with 2 Kbytes of Cache Memory.
e Memories:

— 16 Kbytes of Embedded SRAM (SRAML1) for Program Code (I-Code bus) and
Program Data (D-Code bus and System bus).

— 8 Kbytes of Embedded SRAM (SRAM2) for Program Data (System bus).

— Symmetrical/Asynchronous Dual Core Architecture:

e Interrupt-based Interprocessor Communication.

e Asynchronous Clocking.

e One Interrupt Controller (NVIC) for each core.

e Each Peripheral IRQ routed to each NVIC Input.
— G3-PLC Transceiver:

e Implements G3 CENELEC-A, FCC and ARIB profiles (ITU-T G.9903, June 2014).

e Power Line Carrier modem for 50 and 60 Hz mains.

e G3-PLC coherent and differential modulation schemes available.

e Automatic Gain Control and continuous amplitude tracking in signal reception.

e Embedded PLC Analog Front End (AFE), requires only external discrete high efficient
Class D Line Driver for signal injection.

— Cryptography:
e High performance AES 128 to 256 with various modes (GCM, CBC, ECB, CFB, CBC-
MAC, CTR).

e TRNG (up to 38 Mbit/s stream, with tested diehard and compliant with the American
FIPS Publication specification).

e Classical Public Key Crypto accelerator and associated ROM library for RSA, ECC,
DSA, ECDSA.

e Integrity Check Module (ICM) based on Secure Hash Algorithm (SHA1, SHA224,
SHA256), DMA assisted.

— Safety:
e Up to four Physical Anti-tamper Detection 1/0s with Time Stamping and Immediate
Clear of General Backup Registers.

e Security Bit for Device Protection from JTAG Accesses.
e  Support to PLC coupling boards ATPLCOUPXXX.
e Mains zero-crossing detector circuit.
e  External Memories:
— Serial EEPROM (do not populate).
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— DataFlash memory.
e Peripherals:
— Voltage monitor.
— Back-up battery holder.
— User's LEDs.
— Force Wake Up switch button.
— Tamper switch button.
— Reset button.
— Liquid Crystal Display.
e Interface:
— JTAG debugging port.
— Xplained PRO Master/Slave Interface.
— UARTSs over USB and CMOS levels.
—  Control of 3V3 power supply.
— Non-Isolated RS485 Daisy-Chain Bus.

Figure 3-2. SAM4CP16CMB multi-purpose modem board.
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3.3 Block diagram

Figure 3-3. SAM4CP16CMB Block diagram.
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34 Mechanical and user considerations

This development board is directly powered from mains grid, so hazardous voltage is present on the
board. To avoid user access to dangerous parts, SAM4CP16CMB must always be used in its enclosure.
All required connectors and configuration jumpers are easily accessible without removing the enclosure
cover.

A normal use of the SAM4CP16CMB does not require removing the enclosure cover. If this
action is necessary, it must be performed by qualified staff being sure that mains
connection has been previously removed.

SAM4CP16CMB is a CE mark product which passes EN60950-1 safety standard and EN50065-1,
EN50065-2-3, EN600065-7 EMC standards. It also satisfies Pb-Free and ROHS directive.
SAM4CP16CMB supply voltage is taken from mains grid (100/230Vac, 50-60Hz), J1 connector.

SAM4CP16CMB dimensions are 165mm x 114mm x 30mm (LXWxH) and the enclosure dimensions are
179mm x 130mm x 50mm (LxWxH).

The operating temperature range is about -10 to 85°C.

3.5 Hardware description

In this section the modules of the SAM4CP16CMBV1 board are described. Take into account that the
board’s BOM is not a final design, so they include devices that could be no necessary in the customer
designs once the design has been optimized.

Hardware files are contained in the Hardware folder: “.\Hardware\HW SCH&PCB\SAM4CP16CMBvL1”".
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3.5.1 Power supply

SAMACP16CMB board can be powered either with 100Vac or 230Vac by setting the proper jumpers in
the voltage selector (J2, Figure A-2). J1 IEC-320-C8 connector allows cable connection to mains grid.
This design uses an encapsulated transformer (T1, Figure A-2) plus a full bridge rectifier (D1, Figure A-
2) to obtain a DC voltage without increasing noise in PLC frequency bands (42 to 472 kHz), as may
occur with switched ACDC power supplies. F1 and VR1 are used as protective devices in the equipment
input and F2 protects the transformer output against over current situations.

8 By default, the voltage jumpers’ configuration is for 230Vac. See Figure 6-22.

The maximum transformer output power of 14VA is oversized compared to the maximum current
consumption of SAM4CP16CMB when it is used as a PLC service node. However, this design is
intended to power up other development kits which may have considerable power consumption if they
include components such TFT displays.

The unregulated DC voltage is used as input of the DCDC buck converter - high frequency step-down
switching regulator (U11, Figure A-2) - which generates the configurable Vop voltage. Voo is mainly used
as power supply of the PLC class D amplifier and also as input of the 5V DCDC buck converter -high
frequency step-down switching regulator (U12, Figure A-2)-.

5V voltage rail is only used to provide an external power supply by means of DC jack connector (J15,
Figure A-8). 3V3 is linearly regulated (U13, Figure A-2) and is used to power up SAM4CP16C and all
other digital devices. To measure the current consumption of the 3volts power supply, connect an
ammeter instead of the jumper J19.

Figure 3-4. Power supply diagram.

Transformer 12116V 5V 3v3
& -—Vdc+ Buck —12\\;+ Buck -—6V+ -—BVB+
. 1 LDO
Rectifier Conveter Conveter

Switching frequency of DCDC buck converters used in this evaluation kit has been chosen to be higher
than maximum PLC frequency band supported by SAM4CP16C device.

We recommend characterizing the potential impact of the selected SMPS for customer
designs on the G3 transmission channel.

Vop could be two different voltages, 16volts or 12 volts, depending on the jumper position. If the jumper
is not placed, the voltage Voo is 16 volts. If the jumper is placed in J20, Voo is 12 volts. By default, the
board has a jumper, so board provides 12 volts. These different voltages are used to supply the PLC
coupling driver board.

Be careful with this issue, because the PLC coupling driver board ATPLCOUPXXX could
be damaged. See the features of these boards to know the working voltage.
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Figure 3-5. Vbp selection in SAM4CP16CMB board.
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SAM4CP16CMB can also be powered from USB connector (J9, Figure A-8) or Xplained PRO interface
(J12) without requiring connection to mains. Note that in these cases Voo is not available so the PLC
amplifier cannot be used.

The following test points and LEDs allow checking that these power supplies are running properly (see
Figure A-2):

e Vopp: TP6 and green LED D17.

e 5V:TP5 and green LED D3.

e 3V3:TP13 and green LED D13.

e GND: TP3 & TPA4.

3.5.1.1 Control of 3.3 volts power supply

The SAM4CP16CMB provides activate or deactivate the 3.3 volts regulator by SHUTDOWN pin, SHDN.
User can deactivate the 3.3 volts regulator before enter in a low mode power consumption of
SAM4CP16C, that can be powered by the battery. This allows decrease the consumption of the board.

J21 lets us enable the 3.3 volts regulator always, independently of SHDN pin. By default this option is
deactivated, 3v3 is always on, independently of the value of SHDN, to activate this option remove the
jumper in J21 (Figure A-2).

Figure 3-6. J21 enabling 3.3 volts jumper.

J19

J21
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e By default, jumper J21 is set.

3.5.1.2 Zero crossing detector

A simple isolated circuitry (U9, Figure A-2) is used to detect mains zero crossing events. This VNR
signal is used directly in the PPLC transceiver (VZ Cross) as well as in SAM4CP16C core through an
input (PB11) port as another wake up condition.

3.5.2 SAMA4CP16C Flash Microcontroller
3.5.2.1 SAM4CP16C Overview

The Atmel | SMART SAM4CP16C (U1, Figure A-3) is a member of a family of Flash microcontrollers
based on a dual high performance 32-bit ARM Cortex-M4 RISC processor embedding a G3-PLC
transceiver. These devices operate at a maximum speed of 120 MHz and feature up to 1 Mbyte of
embedded Flash, 128 Kbytes of SRAM and on-chip cache for each core.

The SAMA4CP series is a scalable platform providing, alongside Atmel’s industry leading SAM4 standard
microcontrollers, unprecedented cost structure, performance and flexibility to smart meter designers
worldwide.

The peripheral set includes advanced cryptographic engine, anti-tamper, floating point unit (FPU), 5x
USARTS, 2x UARTS, 2x TWIs, 6 x SPI, as well as 1 PWM timer, 2x three channel general-purpose 16-
bit timers an RTC, a 10-bit ADC, and a 46 x 5 Segmented LCD controller.

It operates from 3V to 3.6V and is available in 176-pin LQFP package.

The ERASE pin can be used to reinitialize the Flash content, so setting a jumper in J14 connector
(Figure A-3), the flash content is erased. This pin integrates a pull-down resistor of about 100KQ, so
that, it can be left unconnected for normal operations. When the ERASE pin is tied high during less than
100ms, it is not taken into account. The pin must be tied high during more than 220ms to perform a
Flash erase operation.

Figure 3-7. J14 jumpe

r, ERASE.

3.5.2.2 SAM4CP16C Clocking

SAMA4CP16C requires a 24MHz crystal oscillator (Y3, Figure A-3) for the PLC transceiver embedded
peripheral. This clock signal is used as internal reference time of the PLC transceiver and also to
generate a 12MHz clock output that may be used by the SAM4CP16C input clock (XIN) when configured
in bypass mode. In this way, only one high frequency crystal oscillator is required.

Nevertheless, SAM4CP16CMB design also allows to use a dedicated crystal oscillator (Y1, Figure A-3)
if a stable frequency different of 122MHz is required as base for SAM4CP16C microcontroller cores. For
this option that is not mounted by default in the board, R34 should be removed and R67 and R68
soldered (they are not populated) and remember that SAM4CP16C must be configured properly.
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A slow clock crystal oscillator of 32.768 kHz (Y2, Figure A-3) is used as clock base in low power mode
and for the embedded Real Time Clock (RTC).

Clocking item is widely detailed in the datasheet, doc43080.

3.5.3 PLC Coupling

Atmel PLC technology is purely digital and does not require external DAC/ADC, thus simplifying the
external required circuitry. Generally Atmel PLC coupling reference designs make use of few passive
components plus a Class D amplification stage for transmission.

Figure A-5 and Figure A-6 show external components required by SAM4CP16C for PLC reception and
transmission respectively.

PLC coupling reference design is composed by the same sub-circuits:
e Coupling Stage.
e Reception Stage.
e Transmission Stage.
e Filtering Stage

Figure 3-8. PLC Coupling example.

RECEPTION
STAGE

TO MAINS COUPLING STAGE FILTERING STAGE

TRANSMISSION
— } g ™ ‘ ’ \ ™  smce

3.5.3.1 Coupling stage

SAM4CP16C

The coupling stage blocks the DC component of the line to/from which the signal is injected / received
(i.e.: 50/60 Hz of the mains). This is carried out by a high voltage capacitor (C26, Figure A-5). Coupling
stage could also voltage isolate the coupling circuitry from the external world by means of a 1:1 PLC
transformer. Capacitor is laying out in SAM4CP16CMB. The optional PLC transformer is included in
ATPLCOUPO0O07 board (voltage isolated), see chapter 4.

Footprint of BNC connector (J17, Figure A-5) is included in the board, but is not mounted by default.
Removing the R12 and R13 and soldering R17 and R18 resistors, the PLC coupling signal can be
isolated from the mains grid and that connector allows performing measurements of transmitted and
received PLC signal without side effects (noise, impedance,..) coming from the grid.

3.5.3.2 Reception stage

The reception stage adapts the received analog signal to be properly captured by the internal reception
chain. Reception circuit is independent of the PLC channel which is being used. It basically consists of:
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e Anti-aliasing filter (RC Filter), R49 & C43, Figure A-6.

e Automatic Gain Control (AGC) circuit. The AGC circuit avoids distortion on the received signal
that may arise when the input signal is high enough to polarize the protective diodes in direct
region (D10, Figure A-6).

e Driver of the internal ADC. The driver to the internal ADC comprises a couple of resistors and a
couple of capacitors. This driver provides a DC component and adapts the received signal to be
properly converted by the internal reception chain.

3.5.3.3 Transmission stage

The transmission stage adapts the EMIT signals and amplifies them if required (Figure A-5). It can be
composed by:

e Driver: A group of resistors which adapt the EMIT signals to either control the Class-D amplifier
or to be filtered by the next stage.

o  Amplifier: If required, a Class-D amplifier which generates a square waveform from O to Voo is
included.

e Bias and protection: A couple of resistors and a couple of Schottky barrier diodes provide a DC
component and provide protection from received disturbances.

Transmission stage shall be always followed by a filtering stage.
3.5.3.4 Filtering stage

The filtering stage is composed by band-pass filters which have been designed to achieve high
performance in field deployments complying at the same time with the proper normative and standards.

The in-band flat response filtering stage does not distort the injected signal, reduces spurious emission
to the limits set by the corresponding regulation and blocks potential interferences from other
transmission channels.

The filtering stage has three aims:

e Band-pass filtering of high frequency components of the square waveform generated by the
transmission stage.

e Adapt Input/Output impedances for optimal reception/transmissions. This is controlled by TXRX
signals.

e And, in some cases, Band-pass filtering for received signals.

When the system is intended to be connected to a physical channel with high voltage or which is not
electrically referenced to the same point then the filtering stage must be always followed by a coupling
stage.

These components are not lying out on SAM4CP16CMB board because are dependent on the
application parameters such frequency band transmission. A set of boards known as ATPLCOUPXXX
have been design by Atmel to implement any possible transmission scheme supported by SAM4CP16C.
SAM4CP16C-EK includes ATPLCOUPO007 and ATPLCOUPO006 which are described in chapter 4 and
5. Other coupling boards have been designed. The Application Note doc43052 provides a description
of the PLC Coupling Reference Designs available and all the features and characteristics.

3.5.3.5 ATPLCOUP boards

Table 3-1 summarizes the main characteristics of currently available PLC coupling reference designs.
Please refer to Atmel doc43052 for a complete description of ATPLCOUP boards.
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Table 3-1. ATPLCOUP boards.

Frequency EIectrlcaI CENELEC :

ATPLCOUPOOG 151-472 kHz | Double 3,4,5,6,7,8
ATPLCOUPO007 35-89 kHz Single Yes 1 A = =
ATPLCOUPO008 35-89 kHz Single No 1 A = =

8 Although different ATPLCOUPXXX can be used on the same SAM4CP16CMB board, they
may require different voltage for the class D amplifier (Vop). As is commented in 3.5.1, Voo
can be regulated to 16 or 12 volts depending on the J20 jumper position. It is important to

note that ATPLCOUPO07 must be used with 12V.

The SAM4CP16C provides the ARIB/FCC frequency band and it allows choosing up to 8 different channels.
This technology only allows one channel active at a time. The limits of each channel are shown in the next
table and can be compared with the table above.

Table 3-2.  Frequency Band limits for each channel.

Start freq. (kHz) End freq. (kHz) CENELEC ARIB

41,992 88,867 X
2 96,68 143,555 X X X
3 151,367 198,242 - X X
4 206,055 252,93 - X X
5 260,742 307,617 - X X
6 315,43 362,305 = X X
7 370,117 416,992 - X X
8 424,805 471,68 = = X

3.5.4 Peripherals

These peripherals are not necessary to implement in a G3 device, they are included to show some
features of the SAM4CP16C for a customer designs.

3.5.4.1 External Memories

SAM4CP16CMB board includes a Flash Memory connected mean a SPI interface (U3/U14, Figure A-
7).

SAM4CP16CMB board includes the possibility to mount a serial EEPROM memory connected by Two
Wires Interface (U2, Figure A-7) with the SAM4CP16C. Please refer to AT24Cxx datasheet for a further
description on Atmel’s website. It is not mounted by default.

3.5.4.2 SAM4C MCU Real Time Clock and back-up battery

Real Time Clock (RTC) embedded peripheral in SAM4CP16C microcontroller can be used as calendar
and time base counter. A back-up battery (Figure A-4), slow clock crystal and low power modes are
required to keep the RTC running during power down or mains unplugged conditions.

22 SAM4CP16C-EK Kit User Manual [USER GUIDE] Atmel

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015



The SAM4CP16CMB includes a Battery (BT1, Figure A-4) for maintain active the RTC when the power
supply of 3v3 shutdown and SAM4CP16C enters in a low-power mode. J18 jumper lets us supply the
board with the battery setting the jumper between VDDBU and BATT position.

Figure 3-9. J18 jumper in battery position.

e By default jumper J18 sets VDDBU to 3V3 supply.

3.5.4.3 Voltage Monitor

SAM4CP16CMB monitors Vop and 5V voltage rails to detect backup mode entering conditions and also
wake up events by means of its dedicated hardware.

5V falling condition is the most recommended trigger event to enter backup mode on SAM4CP16CMB
design:

e Configure PB23 as positive input of analog comparator and compare it with AREF.
e Once 5V rail falls below 4.5V (depending on R70, R74 values) (e.g., mains grid connection has
been removed) the analog comparator interrupt is triggered.

o Before going to backup mode, configure PB23 as wake up port to return to active mode once
power supply is available again.

The wake-up events allow the microcontroller to exit the backup mode. When a wake-up event is
detected, the Supply Controller performs a sequence which automatically enables the core and the
SRAM power supply and clocks. See Figure A-7 for detalils.

Lack of activity on VZ CROSS signal (PB11) can also be used to enter in backup mode.
3.5.4.4 Tamper and Wake-Up

The purpose of backup mode is to achieve the lowest possible power consumption in a system that
executes periodic wake-ups to perform tasks but which does not require fast start-up time.

Wake-up events allow the device to exit backup mode. Force Wake-Up pin, FWUP, can be used as a
wake-up source. In SAM4CP16CMB board, FWUP has been connected to switch button SW3.

Anti-tamper pins (TMPO-TMP3) detect intrusion, for example, into a smart meter case. Upon detection
through a tamper switch, automatic, asynchronous and immediate clear of registers in the backup area,
and time stamping in the RTC will be performed. Anti-tamper pins can be used in all modes. Date and
number of tampering events are stored automatically. Tampering input 0, TMPO, is connected to switch
button SW2. Wake up pins multiplexed with anti-tampering functions are possible sources of wake up
as well in case an anti-tampering event is detected.

3.5.4.5 User leds

The board incorporates two user LEDs (LEDO & LED1), green and red (D5 & D6, Figure A-7), connected
to PB14 and PB15 respectively of the SAM4CP16C.
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3.5.4.6 LCD

An LCD consists of several segments (pixels or complete symbols) which can be visible or invisible. A
segment has two electrodes with liquid crystal between them. When a voltage above a threshold voltage
is applied across the liquid crystal, the segment becomes visible.

The voltage must alternate to avoid an electrophoresis effect in the liquid crystal, which degrades the
display. Hence the waveform across a segment must not have a DC component.

The SLCDC controller is intended for monochrome passive liquid crystal display (LCD) with up to 6
common terminals and up to 50 segment terminals. SAM4CP16CMB board embeds a LCD (DS1, Figure
A-7) of 40 segments and 4 commons. Some of the GPIOS with SLCDC segment functionality are
multiplexed with other functions related to Xplained PRO and BN/MIMO interfaces in SAM4CP16CMB
board. So, if they are used in any other mode rather than LCD segment, they have to be disconnected
from LCD to avoid damaging its structure because of wrong DC bias voltage. Because of these, two
analog switches (U4 and U5, Figure A-7) controlled by PB12 are used as some of LCD segment ports.

LCD backlight can be controlled with SAM4CP16C GPIO PA29.

3.5.5 Interface Ports
3.5.5.1 Reset circuitry

SAM4CP16CMB can be manually reset by using a push button (SW1, Figure A-8) or by means of an
external reset signal available on the Base Node/MIMO interface connector. This reset restarts the
SAMA4CP16C include his PLL.

SAM4CP16C has an asynchronous reset, PC6, and a synchronous reset, PC7, see Figure A-8.
3.5.5.2 SAM4C JTAG Debug Port

The SAM4CP16C JTAG interface is available in a standard 20-pin male header J13 (see Figure A-8)

for debugging and programming purposes. The JTAG/ICE connector is implemented on the

SAM4CP16CMB board for the connection of a compatible ARM JTAG emulator interface, such as the

SAM-ICE from Segger.

Notes: 1. The NRST signal is connected to SW1 system button and also to an external reset signal
available on the Base Node/MIMO interface connector.

2. The 0 ohm resistor R26 may be removed in order to isolate the JTAG port from this system
reset signal.

3. The TDO pin is in input mode with the pull-up resistor disabled when the Cortex M4 is not
in debug mode. To avoid current consumption on VDDIO and/or VDDCORE due to floating
input, the internal pull-up resistor corresponding to this PIO line must be enabled.

Please refer to the SAM4CP16C datasheet for a further description of JTAG debug port.
3.5.5.3 Debugging UARTs

SAMA4CP16C uarts, UARTO and UART1, are user accessible by means of micro USB type B connector
(J9, Figure A-8). A single chip bridge is used to convert UARTs CMOS to USB levels (U8, Figure A-8).
Note that this bridge is powered from USB 5V power supply, so it is only available when USB cable is
attached to any other USB host port. That single chip drive, CP2105-F01-GM of Silicom Labs, has two
ports. The enhanced port is connected to UARTO and the standard port is connected to UART1.

Furthermore, UARTO and UART1 CMOS signals are also available in a triple row male connector (J16,
Figure A-8). If this interface is used, the USB port must remain unconnected to avoid collisions.

Itis possible to power SAM4CP16CMB directly from USB connector. However, due to power limitations,
this option does not allow PLC transmissions. Nevertheless, this option is very useful for several
applications such FW downloading or debugging.
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3.5.5.4 Xplained PRO Master

Xplained Pro is an Atmel’s proprietary interface port intended to connect different development boards,
such as metering and PLC communication boards. This point-to-point interface offers SPI and USART
communication capabilities and requires one target board (master) and an extension module (slave).
SAM4CP16CMB is an Xplained Pro target device with power supply extension connector.

SAM4CP16CMB Xplained Pro provides the following features:

e  SPI (from the SPI1).
e UART (from the USARTL).
e 12C (from the TWIO).
e 2 ADC inputs (from PA4 and PB13).
e 1IRQ input (from PA17).
e 5 GPIO’s (from PA18, PB19, PB20, PB21 and PC8).
SAM4CP16CMB is an Xplained Pro Master device with power supply extension connector (J12, Figure
A-8).
3.5.5.5 RS-485 Interface

J4 and J5 connectors (see Figure A-8) can be used to implement a non-isolated RS-485 daisy chain
bus. This hardware interface has several advantages to implement half-duplex multi-master
communications protocol.

Jumper J3 enables 120 Ohms bus termination impedance that must be connected on the last device of
the daisy chain bus (see Figure A-8).

The same SAM4CP16C UART (USARTO) is used to implement the RS-485 protocol like in the Base
Node/MIMO interface, so if RS485 is used, J8 must remain unconnected and jumper J11 must be set
(see Figure A-8).
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4. ATPLCOUPOO7 Hardware

4.1 Overview

ATPLCOUPOQOQ7 is a single branch with voltage isolation PLC coupling board specially optimized for G3-

PLC. The goal of this design is to provide customers with a cheap performance transmission board in
CENELEC-A band for G3-PLC.

Figure 4-1. CENELEC bands.
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4.2 Features
The ATPLCOUPO007v2 board includes the following features:

e Voltage Isolation from mains with a transformer, MSR EXL-165S-LT, soldered in top layer board.
e Single branch:
— Low impedance optimized.
e CENELEC-A frequency band (35 kHz — 91 kHz). CENELEC EN50065-1 defined a range of low
frequency bands for PLC in Europe. A-band (3-95 kHz) frequency shall only be used for

applications for monitoring or controlling the low-voltage, distribution network, including energy
usage of connected equipment and premises.

Figure 4-2. ATPLCOUPO007v2 PLC Coupling board (top & bottom views).
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26 SAM4CP16C-EK Kit User Manual [USER GUIDE] Atmel

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015



4.3 Mechanical and user considerations

ATPLCOUPOOQ7 is delivered with the SAM4CP16C-EK. Board-to-board SMD connectors, J1 and J2
(Figure A-11), are used to connect the ATPLCOUPOO7 into connectors J6 and J7 of SAM4CP16CMB
board (Figure A-5). These J1 and J2 connectors are in bottom layer of ATPLCOUPOQ07 and they have
the following part numbers:

e J1: SAMTEC FTR-130-54-L-S.

e J2: SAMTEC FTR-124-54-L-S.

The ATPLCOUPO0O07 board is directly powered from mains grid, so hazardous voltage is present on the
board. To avoid user access to dangerous parts, ATPLCOUPO07 must always be used in its enclosure.

ATPLCOUPO0Q07 is a CE mark product that passes EN 50065-1, EN 50065-2-3 and EN60065-7 EMC
standards (see doc43052). It also satisfies Pb-Free and ROHS directive. Furthermore, this coupling
design satisfies all ERDF requirements defined in the document “Essais PLC G3” except for input
impedance out of PLC frequency band.

ATPLCOUPO007 dimensions are 51.5mm x 39.5mm x 18mm (LXWxH).
The operating temperature range is about -40 to 85°C.

4.4  Hardware description
Hardware files are contained in the Hardware folder: “.\Hardware\HW SCH&PCB\ATPLCOUPOO7v2”".

441 G3-PLC CENELEC channel - Single Branch

ATPLCOUPOOQ7 is a galvanic isolated reference design which provides a cost optimized PLC coupling
reference design in terms of output signal level over a wide range of load impedance values while
complying with EN5065-1, EN5065-2-3 and EN5065-7 normatives. It supports the frequency band
between 35 and 91 kHz of CENELEC-A band.

ATPLCOUPO0Q07 is composed of only one transmission branch (single branch) which filtering stage has
a flat band pass response with typical field impedances. It involves a cost optimization in the BOM. For
more information, see PLC coupling reference designs document, doc43052.

Take into account that, when ATPLCOUPOOQ7 is connected to SAM4CP16CMB, Vop voltage must be 12
volts to avoid damaging the coupling board, so jumper in J20 must be set (see section 3.5.1 and Figure
A-2). By default, the jumper is placed.

Figure 4-3. Vobp selection in SAM4CP16CMB board.
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configuration
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ATPLCOUPOO06 Hardware

Overview

ATPLCOUPOQO6 is a PLC coupling board designed to communicate in ARIB and FCC bands, especially
from 151 to 472 kHz (channels 3, 4, 5, 6, 7 and 8). ATPLCOUPO006 mounts a double branch with voltage
isolation from mains to the PLC coupling driver board. The goal of this design is provided to the cus-
tomers with a full performance transmission board in FCC band. This board is not set by default in the
SAM4CP16CMB board of the SAM4CP16C-EK.

Figure 5-1. FCC and ARIB bands.

| CENELEC A, 'CENELEC BCD, | :
[3..95] kHz [95..148.5] kHz :
73 kHz r:. kHz 7.3 kHz 7.3 kHz
[kHz]: 42 144 151 198 206 253 261 308 315 362 370 417 424 To47T f
Features

The ATPLCOUPOQ06v1 board includes the following features:

e Specially designed to communicate in ARIB and FCC frequency bands (151,367 — 471,68 kHz).

e Voltage Isolation from mains with a transformer, VAC T60403K5024X044, soldered in top layer
board.

e Double branch, each one for a range of impedances:
— Low impedance optimized.
— High impedance optimized.

Figure 5-2. ATPLCOUPO006v1 PLC coupling board.

Test point.
Test point.

Test point to measure the PLC signal.

TX led indication.

PLC transformer provides the
voltage isolation from mains.

ras Test point.

Mechanical and user considerations

ATPLCOUPOO06 is delivered with the SAM4CP16C-EK. Board-to-board SMD connectors, J1 and J2, are
used to connect the ATPLCOUPOO6 into connectors J6 and J7 of SAM4CP16CMB board (Figure A-4).
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These J1 and J2 connectors are in bottom layer of ATPLCOUPQO06 and they have the following part
numbers:

e J1: SAMTEC FTR-130-54-L-S.
e J2: SAMTEC FTR-124-54-L-S.

The ATPLCOUPOQ06 board is directly powered from mains grid, so hazardous voltage is present on the
board. To avoid user access to dangerous parts, ATPLCOUPO006 must always be used in its enclosure.

ATPLCOUPOQO06 is a CE mark product that passes EN 50065-1, EN 50065-2-3, EN60065-7 EMC and
FCC (as current carrier system) standards. It also satisfies Pb-Free and ROHS directive.

ATPLCOUPOQ06 dimensions are 51.5mm x 39.5mm x 18mm (LXWxH).
The operating temperature range is about -40 to 85°C

54  Hardware description
Hardware files are contained in the Hardware folder: “.\Hardware\HW_SCH&PCB\ATPLCOUPOO06v1".

5.4.1 G3-PLC FCC channels - Double Branch

ATPLCOUPO0O06vV1 board is a PLC coupling driver board with double branch design and galvanic voltage
isolation. ATPLCOUPOQO06 has been designed to transmit in ARIB and FCC band, especially in bands
from 151 to 472 kHz (channels 3, 4, 5, 6, 7 and 8).

It has a good performance in terms of transmitted channel power over a range of load impedance values
complying with FCC standard as current carrier system, see FCC normative. ATPLCOUPO0O06 is com-
posed of two transmission branches which only differ on the filtering stage. A 12V power supply voltage
for the class-D amplifier is recommended to be used with ATPLCOUPOQO06.

For more information, see PLC coupling reference designs document, doc43052.

Take into account that, when ATPLCOUPOQOQ6 is connected to SAM4CP16CMB, Vop voltage must be 12
volts to avoid damaging the coupling board, so jumper in J20 must be set (see section 3.5.1 and Figure
A-2). By default, the jumper is not placed.

Figure 5-3. Vbp selection in SAM4CP16CMB board.
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6. SAMACP16C Evaluation Kit: Getting started

The purpose of this chapter is to introduce you the Atmel | SMART SAM4CP16C device and its
functionalities.

First of all, chapter 6.1, IDE tools are presented to create, build, program and debug your application.

Chapter 6.2 describes a simple PLC application that lets you check the device communication in a point-
to-point connection (PHY layer example).

Chapter 6.3 describes the PHY TX Test Console application, which lets you configure a proper setup to
perform both EMC emissions and immunity tests on SAM4CP16CMB board.

Chapter 6.4 describes the G3 PHY Sniffer project, which, is able to monitor data traffic on the G3
network.

Chapter 6.5 describes the G3-PLC Stack and we present you the structure of a G3-PLC project and
how to create a final application.

Finally, chapter 6.6 explains the setup and operations required to create a smart PLC network using the
included G3-PLC Device example and G3-PLC Coordinator example. This network communicates by
means of G3-PLC.

Note: The software described in this manual is under the Atmel's Evaluation License Agreement.pdf
document. You can find it in the Software folder.

6.1 Introduction to the integrated development environment

The purpose of this section is to guide new users through the initial settings of IAR Embedded
Workbench or Atmel Studio, and compile a G3 project. The section shows setup of a G3 project to
generate a debug target that can be loaded into the microcontroller.

Kit projects are supported by IAR 7.40 or AS 6.2 versions or above. From this point on, it is assumed
that a working copy of these IDE is installed in your computer. The IAR’s homepage, http://www.iar.com,
is a suitable source to download (i.e.: 30-day time-limited evaluation license). And the Atmel's
homepage, http://www.atmel.com, is suitable for downloading the Atmel Studio 6 (free download).

6.1.1 IAR Embedded Workbench

IAR Embedded Workbench is a high-performance C/C++ compiler assembler, linker, librarian, text
editor, project manager, and C-SPY® Debugger in an integrated development environment for
applications based on 8-, 16-, and 32-bit microcontrollers. IAR Embedded Workbench is compatible with
other ARM EABI compliant compilers and supports the SAM4C core family (example projects are
developed only for 7.10.1 versions or above).

6.1.2 Atmel Studio

Atmel Studio 6 is the integrated development platform (IDP) for developing and debugging Atmel ARM
Cortex-M and Atmel AVR® microcontroller (MCU) based applications. The Atmel Studio 6 IDP gives you
a seamless and easy-to-use environment to write, build and debug your applications written in C/C++
or assembly code.

Atmel Studio 6 is free of charge and is integrated with the Atmel Software Framework (ASF) — a large
library of free source code with 1,600 ARM and AVR project examples. ASF strengthens the IDP by
providing, in the same environment, access to ready-to-use code that minimizes much of the low-level
design required for projects. Use the IDP for our wide variety of AVR and ARM Cortex-M processor-
based MCUSs, including our broadened portfolio of Atmel SAM3 ARM Cortex-M3 and M4 Flash devices.
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Figure 6-1. Atmel Studio 6.

Atmel Powered by Visual Studio

Download the latest version from the following link: http://www.atmel.com/microsite/atmel_studio6/

6.1.3 Atmel SAM-ICE JTAG Probe

Atmel SAM-ICE (a dedicated Atmel J-Link version) is a USB-powered JTAG emulator supporting Atmel
ARM-based microcontrollers.

Atmel SAM-ICE is a JTAG emulator designed for SAMA5, SAM3, SAM4, SAM7 and SAM9 ARM core-
based microcontrollers, including the Thumb® mode. It supports download speeds up to 720 Kbytes per
second and maximum JTAG speeds up to 12 MHz. It also supports Serial Wire Debug (SWD) and Serial
Wire Viewer (SWV) from SAM-ICE hardware V6.

SAM-ICE support is integrated in most professional integrated development environments (IDEs) such
as IAR and many others.

More details are available here: http://www.atmel.com/tools/ATMELSAM-ICE.aspx.

Figure 6-2. Atmel SAM-ICE JTAG.

Note: Evaluation kit does not provide an Atmel SAM-ICE.

To use Segger tools with Atmel Studio 6.2, download Atmel's latest USB driver driver-atmel-bundle-
7.0.712.exe from the following link: https://gallery.atmel.com/Products/Details/07bf16c1-444f-4ac8-
8f40-9d4005575dca or take it from the PCTools folder: “\PCTools\USB_Drivers”. And install the file.

6.1.4 J-Link / SAM-ICE JTAG Probe Software & Documentation Pack

The J-Link / SAM-ICE JTAG software and documentation pack includes:
e GDB Server - Support for GDB and other debuggers using the same protocol. GUI & command
line version.

e J-Link Configurator - Free utility to manage a various number of J-Links connected to the PC via
USB or Ethernet.

e J-Link Commander - Simple command line utility, primarily for diagnostics and trouble shooting.
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e J-Link Remote Server - Free utility which provides the possibility to use J-Link / J-Trace remotely
via TCP/IP.

e  SWO Viewer - Free tool which shows terminal output of the target performed via SWO pin.

e J-Mem - Memory viewer.

e J-Link DLL Updater - Allows updating 3rd party applications which use the J-Link DLL.

e Free flash programming utilities - Simple command line utilities which allow programming a bin
file into the internal/external flash memory of popular evaluation boards.

e  USB driver (Includes driver for J-Links with CDC functionality).

e Manuals: UM08001 (J-Link User Guide), UM08003 (J-Flash User Guide), UM08004 (RDI User
Guide), UM08005 (GDB Server User Guide), UM08007 (Flasher ARM User Guide).

e Release notes for J-Link DLL, J-Flash and J-Link RDI DLL.

e J-Flash, including sample projects for most popular evaluation boards.

e J-Link RDI — Support for ARM RDI standard. Makes J-Link compatible with RDI compliant
debuggers.

Installing the software will automatically install the J-Link USB drivers. It also allows the update of
applications that use the J-Link DLL.

The last version of the driver for the SAM-ICE JTAG Probe can be downloaded from the
http://www.segger.com website using the following link: http://www.segger.com/jlink-software.html. The
package for Windows, Setup_JLInkARM_V496b.zip, is located in the following folder: “\PCTools\SAM-
ICE Driver”.

SEGGER adds flash programming support for Atmel ATSAM4CP16C in version 4.90 (July
2014) or above.

Once drivers have been installed you may verify the driver installation by consulting the Windows®
device manager. If the driver is installed and your SAM-ICE is connected to your computer, the device
manager should list the J-Link driver as a node below "Universal Serial Bus controllers" as shown in the
following screenshot.

Figure 6-3. Device manager.
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6.1.5 Atmel Software Framework (ASF)

The Atmel Software Framework (ASF) is a collection of embedded software for the Atmel Flash MCUs:
megaAVR, AVR XMEGA, AVR UC3 and SAM devices.

It simplifies the use of our microcontrollers by providing an abstraction to the hardware and high-value
middleware. ASF is designed to be used for evaluation, prototyping, design and production phases. The
intention of ASF is to provide a rich set of proven drivers and code modules developed by Atmel experts
to reduce customer design-time. It simplifies the usage of microcontrollers, providing an abstraction to
the hardware and high-value middleware.

ASF is integrated in the Atmel Studio IDE with a graphical user interface or available as standalone for
GCC, IAR compilers. ASF can be downloaded for free. ASF is an open-source code library designed to
be used for evaluation, prototyping, design and production phases.

The Atmel Software Framework is split in six main parts, the avr32/ directory, the xmega/ directory, the
mega/ directory, the common/ directory, the sam/ directory and the thirdparty/ directory. These six
directories represent the Atmel AVR UC3 architecture, the Atmel megaAVR, the Atmel AVR XMEGA
architecture and the Atmel SAM architecture, what are common between all architectures and finally
third party libraries.

Each architecture (and the common directory) is split into several subdirectories, these directories
contain the various modules; boards, drivers, components, services and utilities.

See the list below and Figure 6-4 for an overview of how the various modules are wired together:
e Boards contain mapping of all digital and analog peripheral to each I/O pin of Atmel's development
kits.
e Drivers is composed of a driver.c and driver.h file that provides low level register interface

functions to access a peripheral or device specific feature. The services and components will
interface the drivers.

e Components is a module type which provides software drivers to access external hardware
components such as memory (e.g. Atmel DataFlash®, SDRAM, SRAM, and NAND flash),
displays, sensors, wireless, etc.

e Services is a module type which provides more application oriented software such as a USB
classes, FAT file system, architecture optimized DSP library, graphical library, etc.

e  Ultilities provide several linker script files, common files for the build system and C/C++ files with
general usage define, macros and functions.

o Applications provide application examples that are based on services, components and drivers
modules. These applications are more high level and might have multiple dependencies into
several modules.

Figure 6-4. ASF modules structures.
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Download link for more information: http://www.atmel.com/tools/AVRSOFTWAREFRAMEWORK.aspx.
Please do not hesitate to visit our web site to get the last library updates.

6.1.6 First steps with IAR Embedded Workbench

When working with programming in general it is important to have some structure in your coming
projects and code. IAR Embedded Workbench is made to support such demands. The upper abstraction
of a task is called Workspace, within each workspace you can add projects. The projects added in a
workspace could be supporting the same device or have something in common. Each project contains
code and settings for each target. So what we need to do is first make a workspace, then add a new
project to this workspace. When this is done you should be able to include an application code to your
project and make all the settings for the target SAM4CP16C on your SAM4CP16CMB board.

IAR Embedded Workbench 7.10.1 version does not support all the SAM4CP core family, i.e.,
SAMACP16C. Due to this, you have to install the provided patches in the kit, IAR-EWARM-
ATSAM4CP16C_0-1.1.1.601.zip and IAR-EWARM-ATSAM4CP16C_1-1.1.1.601.zip. The first .zip file
is the patch for the core 0 and the second one is for the core 1. You can find them in the following
directory: “\Software\Compiled_Patches\/AR”. Process to install the patches should be:

1. Unzip the .zip files.
2. Open the new folder unzipped.
3. Merge the contents of three inside folders, config, examples and inc with the same folders where

the IAR has been installed in your computer. Typical directory for windows (64bits) should be:
c:\Program Files (x86)\IAR Systems\Embedded Workbench X.X.X\arm\.

Once have installed the IAR Embedded Workbench. Open IAR Embedded Workbench. Click the Start
button on the Windows taskbar and choose All Programs>IAR Systems>IAR Embedded Workbench for
ARM>IAR Embedded Workbench. The file larldePm.exe is located in the common\bin directory under
your IAR Systems installation, in case you want to start the program from the command line or from
within Windows Explorer. The workspace file has the filename extension eww. If you double-click a
workspace filename, the IDE starts. If you have several versions of IAR Embedded Workbench installed,
the workspace file is opened by the most recently used version of your IAR Embedded Workbench that
uses that file type, regardless of which version the project file was created in.

The following figure shows the main window and its default layout.
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Figure 6-5. The IAR Embedded Workbench window.
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Let’'s have a closer look to the environment now. Basically, the environment is split into five different

e  Editor window: allows you to edit the source files.

e  Workspace window: shows the project structure.

e Message window: displays messages from the compiler.
e  The Menu bar lets us the menu commands.

e The IDE toolbar—available from the View menu—provides buttons for the most useful commands
on the IDE menus, and a text box for typing a string to do a quick search.

e The Status bar at the bottom of the IAR Embedded Workbench IDE main window —available from
the View menu— contains useful help about how to arrange windows that they can be enabled
from the View menu.

Open the G3-PLC workspace for SAM4CP16C platform, sam4cpl6c_PLC_examples.eww. For that, on
the start page, click on File>Open>Project/Solution. And select the project in the folder:
“\Software\G3_va.b.c_ CENELEC\g3.workspace.sam4cpl6c_sam4dcpl6cmb\thirdparty\g3\apps\apps_
workspace_sam4cpl6c_sam4dcplécmbliarew _workspace\sam4cpl6c_PLC_examples.eww”.

Once you have loaded the workspace, you can see the three G3-PLC PHY example projects and both
G3-PLC DLMS applications. Open the APPS DLMS EMU_ COORD project. And now, you can see the
G3 PHY project structure (expand the tree structure) in the workspace window. That structure is showed
in the previous figure.

6.1.6.1 Building, programming and debugging a project with IAR

Now you can create, build, program and debug the Atmel G3-PLC Examples using the IAR. But before
to do this, you can configure and customize your project as you want; i.e., adding the Output window,
show the line numbers, change the language options, etc.

Tool Output window is available by choosing View>Messages>Tool Output. The Tool Output window
displays any messages output by user-defined tools in the Tools menu, provided that you have selected
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the option Redirect to Output Window in the Configure Tools dialog box. When opened, by default, this
window is grouped together with the other message windows.

Figure 6-6. Tool Output window.

Output

:Dehug LUXUE Tool Dutput lhuldziﬁnd nAes: W
LR R S et R e S S R S S S A R R A S o

The Language options are available by choosing Tools>Options. Use this page to specify the language
to be used in windows, menus, dialog boxes, etc.

For example, it is very useful to enable line number display feature. For that, show the editor window
and tick the Show line numbers options. Editor options window is available in Tools>Options. In addition
to this, you can use this window to configure the editor.

In order to build the project, choose a build configuration in the combo box of the workspace window.
By default, the IDE creates two build configurations when a project is created—Debug and Release.
Every build configuration has its own project settings, which are independent of the other configurations.
For example, a configuration that is used for debugging would not be highly optimized, and would
produce output that suits the debugging. Conversely, a configuration for building the final application
would be highly optimized.

You can build your project either as an application project or a library project. You have access to the
build commands both from the Project menu and from the context menu that appears if you right-click
an item in the Workspace window. To build your project as an application project, choose one of the
three build commands Make (F7), Compile (Ctrl+F7), and Rebuild All. They will run in the background,
S0 you can continue editing or working with the IDE while your project is being built.

Error messages are displayed in the Build window. If your source code contains errors, you can jump
directly to the correct position in the appropriate source file by double-clicking the error message in the
error listing in the Build window, or selecting the error and pressing Enter. After you have resolved any
problems reported during the build process, you can directly start debugging the resulting code at the
source level.

Process to build, compile, load and debug the project over the board could be:

oog

1. Choose Project>Make or click the Make button _*%
with no errors.

2. Connect the SAM-ICE JTAG probe.

3. Supply on the board.

on the toolbar. The part should compile

4. Choose Project>Download and Debug or click the Download and Debug button 2 on the
toolbar to download your program to the board.

5. The file main.c is now open in the editor window and the program is stopped at the start. Choose
tL 2]

Debug>Go or click the Go button =*! on the toolbar to start the application. Your IAR IDE
window should now look like as Figure 6-7.

6. Once the board is powered, the green led D5, LEDO, is blinking and the display, DS1, shows the
following message: G3 PTT.
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6.1.7

Figure 6-7. The IAR Editor window.
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@ common 94 /* Start 0SS */
Ha0ipvé 95 oss_starc();
Calibs |
i e o L
W[ [Overview _spps_dims_emu_coord_spp.fash | spps_dims_emu s[5 ||, S e
Messages File Line
Building configuration: apps_dims_emu_coord_app_flash - Debug
Updating build tree. .
Configuration is up-to-date.

2 Debuglog. Buid

R Errors0, Wamings0__ Ln84, Coll System NUM
ot — = ————r——r——

(1

nop
Lyia

To stop C-SPY, click the Break button on the debug bar.

To exit C-SPY, click the Stop Debugging button X on the toolbar.

To exit the IAR Embedded Workbench IDE, choose File>Exit. You will be asked whether you
want to save any changes to editor windows, the projects, and the workspace before closing
them.

© © N

For examples of building application and library projects, see the tutorials in the Information Center. For
more information about building library projects, see the IAR C/C++Development Guide for ARM.

First steps with Atmel Studio 6.2

Atmel Studio 6.2 does not support all the SAM4CP core family, i.e., SAMACP16C. Due to this, you have
to install the provided patch in the kit, PartPack_ATSAMA4CP16C-trunk-6.2.0.vsix. For that, execute the
.msi file and follow the installation wizard. You can find it in the following directory:
“\Software\Compiled_Patches\AtmelStudio”.

Once Atmel Studio 6.2 is installed in your computer, launch Atmel Studio 6.2. Click the Start button on
the Windows taskbar and choose All Programs>Atmel>Atmel Studio 6.2. The workspace file has the
filename extension atsIn. If you double-click a workspace filename, the IDE starts.

Note: Opening Atmel Studio 6.2 takes some time.

The following figure shows the main window and its default layout.
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To avoid problems depending on the length of the path with Atmel Studio, we recommend
install the evaluation kit contents in the root C:\.

And now, you can open the G3 workspace for SAM4CP16C platform, sam4cpl6c PLC examples.atsin.
For that, you have to click on Open Project or on File>Open>Project/Solution on the Start page and
select the project in the folder:

“\Software\G3_va.b.c_ CENELEC\g3.workspace.sam4cpl6c_samdcplecmbithirdparty\g3\apps\apps_
workspace_samdcpl6c_sam4cpl6cmblas_solution\sam4cpl6éc PLC_examples.atsin”.

Once you have loaded the workspace, you can see the three G3-PLC PHY example projects and both
G3-PLC DLMS applications. Open the APPS DLMS EMU_COORD project. Once a project is opened,
the Solution should appear in the integrated development environment as in the figure below.
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Figure 6-9. Atmel Studio 6.2 interface.
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Let's have a closer look at the environment now. Basically, the environment is split into three different
areas:

Atmel Studio Editor: allows you to edit the source files.
Solution Explorer: shows the project structure.

e  Output Window: displays messages from the GCC compiler.

In the solution explorer window you can see the G3-PLC project structure (expand the tree structure).
That structure is showed in the Figure 6-9.

6.1.7.1 Building, programming and debugging a project with AS

Now you can create, build, program and debug the Atmel G3 Examples using the AS. But before to do
this, you can configure and customize your project. For example it is very important to enable line
number display feature in Atmel Studio 6.2 editor. For that:

e Access to Editor Function by clicking on Tools>Options and access to All Languages window in
the Text Editor tab.
e Enable the Display Line numbers function.
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Figure 6-10. Line numbers enabling.
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Another important feature is to disable the optimization in Atmel Studio 6 editor when you are in Debug
mode to avoid jumping into the lines of code without order —due to the optimization-. For that:
e Access to Project Properties by clicking on Project>APPS_DLMS_EMU_COORD Properties and
access to Toolchain window in the Project Properties tab.
e  Select Optimization option in ARM/GNU C Compiler main tree.
e Select None option in the display Optimization Level function.

Figure 6-11. Optimization option window.
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In order to build the project, click on the Build Solution button == or on Build>Build Solution.

Make sure the SAM/ICE cable is connected from your board to your PC through the J13 connector.
Power the SAM4CP16CMB board.
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Then, download the program in the internal flash of the SAM4CP16C by clicking on the Start Debugging
kil

and break button

The first time Atmel Studio will ask to select the Debug Tool. Select the on-board SAM-ICE (the serial
number in parenthesis differs from one Debug Tool to another), see Figure 6-12.

Figure 6-12. Select tool instance.

EEia,.................

Build

Build Events

Toolchain Selected debugger/programmer

gger/prog
Device SAM-ICE « 28011489 « || Interface:| |{TAG '] [Jlmk Control Panel

Advanced

JTAG Clock
N 400MHz

Manual Clock -

ITAG Daisy chain settings
© Target device is not part of a JTAG daisy chain

SRR Position MName IRLength

Device at position 1 has TDI pin connected directly to debugger.

Programming settings

Erase entire chip Boot selection |Unchanged

Once programmed, start the code execution by clicking on the green arrow W .

When the debug session is running, the Stop button 4 allows you to stop the program execution and
exit the debug session. If you just want to stop the program and keep the debug session active, simply

click on the Pause button I

If you modify any of the files of the project, you need to do a Rebuild and not only a Build. Do a right-
click on the project name in the Solution Explorer and then click on the Rebuild button.

Once the board is powered, the green led D5, LEDQO, is blinking and the display, DS1, shows the
following message: G3 COO.

Figure 6-13. LCD message with PHY tester tool application binary programmed.
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6.2

42

Figure 6-14. Atmel Studio 6.2 window.
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In case you only want to download the program on the SAM4CP16C without debugging, clicking on the

Start Without Debugging button |
Close the project on the toolbar File>CloseSolution.

For further information, please refer to the tool’'s embedded help (in the menu bar) or visit the webpage:
http://www.atmel.com/microsite/atmel_studio6/default.aspx.

PLC application example 1 — PHY Tester

The boards of the kit, by default, are programmed with the embedded PLC PHY Tester tool firmware for
SAM4CP16C device, apps_phy tester tool.bin. It is an application example that shows the capabilities
of the SAM4CP16C in a point-to-point connection (physical layer). This application requires a pair of
boards and a PC tool, Atmel PLC PHY Tester tool, which has to be installed in the user’s host PC to
interface with the boards.

In any case, boards could be loaded with a previous binary file version of this application. So, we
recommend to load this file again previously to evaluate the boards. For that, you have to build the
project apps_phy_tester tool to generate the output file to program. See section 6.2.4 to know more
about programming the SAM4CP16CMB boards.

Atmel recommends to load the binary generated with the last PHY Tester Tool project
released in the kit to evaluate the board with last improvements.

After installing the Atmel PLC PHY Tester tool in your PC(s), connect the boards to the grid and to the
host(s) PC(s) as shown in the following figure.
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Following chapters explain to you how to install the PC tool, supply the boards, and select the UARTO
to communicate with the SAM4CP16C. Load the firmware and run the application.

6.2.1 Atmel PLC PHY Tester tool Installation

To install Atmel PLC PHY Tester tool in a Windows Operating System, execute the provided installer in
the Tools folder: “\PCTools\ATMEL_PLC_PHY_ TesteNATMEL_PLC_PHY_ Tester _Tool vX.Y.Z.exe”,
and follow the installation wizard. The installer wizard should open. To follow with the installation, click
Next.

Figure 6-16. Installation process, slide 1.
Choose Users

'y
Choose for which users you want to install Atmel PLC PHY Tester Tool. 67

Select whether you want to install Atmel PLC PHY Tester Tool for yourself only or for all users
of this computer. Click Next to continue.

(@) Install for anyone using this computer

() Install just for me

Mullsoft Install System w246

[ Next = ][ Cancel

Select the users’ permissions and click Next.
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Figure 6-17. Installation process, slide 2.

{57 Atmel PLC PHY Tester Tool Setu C=NEE X

Welcome to the Atmel PLC PHY
Tester Tool Setup Wizard

This wizard will guide you through the installation of Atmel
PLC PHY Tester Tool.

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue,

< Back ][ Next = ] [ Cancel

Click Next to continue.

Figure 6-18. Installation process, slide 3.

{1 Atmel PLC PHY Tester Tool Setup —Elﬂlg

License Agreement -
Please review the license terms before installing Atmel PLC PHY Tester Toal. (

Press Page Down to see the rest of the agreement.

[=VALUATION LICENSE AGREEMENT -

IT IS IMPORTANT THAT YOU READ THIS AGREEMENT CAREFULLY AND COMPLETELY.

This Evaluation License Agreement ("Agreement”) is a legally binding agreement between
your employer ("Licensee”) and Atmel Corporation ("atmel”). By dlicking the "I Accept”
button or by downloading, installing or using any of the software available for download
("Licensed Software”), you are indicating that you are binding Licensee to the terms of

this Agreement, and that you are duly authorized by Licensee to do so. If you are not
authorized to bind Licensee to the terms of this Agreement, or if Licensee does not

agree to be bound by all of the terms of this Agreement, do not dick the " Accept” -

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install Atmel PLC PHY Tester Tool.

'y

< Back ][ I Agree ] [ Cancel

Click | Agree to continue.
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Figure 6-19. Installation process, slide 4.

Choose which features of Atmel PLC PHY Tester Tool you want to install. 'y

install. Click Next to continue.

Space required: 53.7MB

n

Check the components you want to install and uncheck the components you don't want to

Select components to install: Atmel PLC PHY Tester Tod -
Position yaour mouse

Description

over a component ko
see its description.

Mullsoft Install System v, 46

[

<Back || mext> | [ cancel

Click Next.

Figure 6-20. Installation process, slide 5.
{51 Atmel PLC PHY Tester Tool Setup

Choose Install Location
Choose the folder in which to install Atmel PLC PHY Tester Tool, 9

Destination Folder

Space required: 54. 1MB
Space available: 288.7GE

Setup will install Atmel PLC PHY Tester Tool in the following folder, To install in a different
folder, dick Browse and select another folder. Click Install to start the installation.

:\Program Files (x86) \Atmel\Atmel PLC PHY Tester Tool 2.3.2]

Mullsoft Install Syskem w2, 46

[ <Bak |[ msal | [ concel |

Setup will install the program in the Destination Folder. To install in a different folder, click Browse and
select your destination folder. Click Install.
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Figure 6-21. Installation process, slide 6.
{7 Atmel PLC PHY Tester Tool Setup _Elﬂlg

Completing the Atmel PLC PHY
Tester Tool Setup Wizard ‘

Atmel PLC PHY Tester Tool has been installed on your
computer.

Click Finish to dose this wizard.

< Back Cancel

Click Finish.
Now the program is installed in your computer and a shortcut should have been created in your desktop.

6.2.2 Supplying the boards

Kits are provided with power cord cables in order to connect the boards to the mains. Mains connector
is shown below in Figure 6-22. Please connect the provided power cord cable with the kit to the Power
Cord Connector, J1, in order to supply the board.

Figure 6-22. SAM4CP16CMB mains and voltage jumper selector.

Jumper VoIta’e Selector: 230 Vac option

230VAC[E&=21)
115VAC 23

Note that the SAM4CP16CMB board can be supplied either with 100Vac or 230Vac by setting the proper
jumpers in the voltage selector, J2, as depicted in the Figure 6-23. By default, voltage jumper is set for
230Vac. For more information about power supply section, see section 3.5.1.

Figure 6-23. Jumper configuration for 100Vac or 230Vac.

230VAC

115VAC [
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6.2.3 USB connection

By default, the programmed firmware for Atmel PLC PHY Tester tool establishes serial communication
with UARTO. Boards have such UARTO available either by micro-B USB connector, J9, or the triple pin
row CMOS connector, J16. See the figure below and sections 3.5.5.3 for more information about the
USB device. Kits are provided with two micro USB cables in order to connect the user’s host(s) PC(s)
with the two boards.

Figure 6-24. UART & JTAG connectors.

<4— JTAG Connector

Connect the USB cable to the micro-B USB connector and the host PC. If the PC does not recognize
the USB, download the USB driver from the manufacturer webpage or take it from the PCTools folder:
“\PCTools\USB_Drivers”. Once the driver is downloaded, unpack the driver archive to a folder on the
host PC’s hard-disk. Connect the USB cable to the board. The new hardware installation will recognize
the new board and will guide you through the USB driver installation. When the wizard asks for the driver
to install, navigate to the directory where the driver archive has been unpacked to.

Identify the new hardware in the Windows Device Manager. The assigned COM port number is needed
when configuring the PHY Tester tool application later. See the following figure for an example of a
COM port assignment.
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Figure 6-25. Device manager.
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As you can see in the figure above, the CP210x USB to UART Bridge Virtual COM Port (VCP) appears
as two COM ports (Enhanced and Standard COM ports) in the Device Manager. They are assigned the
lowest available COM ports for operation. In the SAM4CP16CMB design, the Enhanced COM port
corresponds to UARTO and the Standard COM port to UART1, so select the Enhanced COM Port when
you use the Atmel PLC PHY Tester PC tool.

6.2.4 Programming the embedded file

The boards of the kit are programmed with the embedded PLC PHY Tester tool firmware for
SAMACP16C device, apps_phy_tester_tool.bin. In this chapter we explain how to load an embedded
file. The process and tools to load the embedded file in the SAMACP16CMB boards are always the
same. Remember that all these tools and performance are described in chapter 6.1.

To be able to develop applications, build binaries and program the firmware on the SAM4CP16C device,
you can use the IAR Workbench or the Atmel Studio.

In order to program the firmware on the board, the JTAG connector is used (see section 3.5.5.2 about
JTAG programming mode) and JTAG probe is required. See previous Figure 6-24, which shows the
JTAG connector, J13, of the board. Note that kits do not provide a J-Link ARM or SAM-ICE JTAG
probe in order to connect to the user’s host PC and the boards to download and debug the
projects.

The process to load the file should be as is explained below; in that process we use a programming tool,
J-Link Tool. Remember that the J-Link USB drivers must have been downloaded previously from the
Segger webpage (see section 6.1.4) and they depend on your operating system:
1. Place the JTAG connector of the J-Link or SAM-ICE in the J13, JTAG connector of the board.
Check pin number 1 of J13 connector to place the cable in the right position. See the Figure 6-
24,
2. Switch on the power supply of the board.
3. There are two ways to program the board:
a. Launch the IAR or Atmel Studio and select the PHY Tester tool project. Build the project
apps_phy tester.atsIn or apps_phy_tester.eww to generate the output file to program. Now
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you can download the file to the board. Process to load the output file is commented in
sections 6.1.6.1 and 6.1.7.1.

b. In case the output file has been previously created, you can use the Device Programming
Instance of the Atmel Studio IDE to load the program in the flash memory. In the menu bar,
go to Tools>Device Programming. Select the tool, device and interface and press Apply
button. Go to Memories window, select the output file (.hex or .elf) and press Program
button. When finished, power cycle the board to run the program.

Remember that, every PHY example project is contained in the following Software folder:
“ISoftware/G3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_sam4cpl6cmblthirdparty\g3\
phy\atpl250\apps”.

And also you can find all of them in the workspace project, sam4cpl6¢c_PLC_examples,
which is contained in following Software folder:
“\Software\G3_va.b.c_CENELEC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\
apps\apps_workspace_sam4cpl6c_samdcplécmb\”.

Figure 6-26. Device Programming instance.

SAM-ICE (28011489 - Device Programming | ? B9 |
Tool Device Interface Device signature Target Vo
SAM-ICE = | ATSAMMCPIGC O = |ITAG = ||Apply OxAB4 COCED @ 3.2V l Rea
Interface settings Device
Tool information [Erase Chip '] [ Erase now ]
Device information Flash {1024 KE)
1250vappsiphy_tester_toalisamdcplic_samdcplécmbiasi_arm\Debug\APPS_PHY_TESTER_TCOCLhex ~ E]
" 7 .
GPMNVM Bits Erase Flash before programming [ T ] [ == ] [ Read.. ]
Lock bits
Security JLink Config

JLink Control Panel |

Getting Vtarget...OK

E] Getting Vtarget..OK

]

PHY Tester Tool project of G3_va.b.c_ CENELEC folder has been created for the default PLC coupling
board, ATPLCOUPO007v2. So, if you are going to use ATPLCOUPO006v1 coupling board, you must use
G3 _va.b.c_FCC folder to build the PHY Tester Tool project with the correct configuration. For that, open
the IDE tool used, Atmel Studio or IAR Embedded Workbench. And open the project application,
apps_phy_tester_tool.atsln or apps_phy_tester_tool.eww.

After that, you can select the file conf_project.h, that it is located in the following project directory:
“/Software\G3_va.b.c_FCC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\phy\atpl250\apps\
phy tester tool\sam4cpl6c _sam4cplécmb”, find the define function to select the coupling board
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configuration (see Figure 6-27) and check the frequency band name is the desired. So build to generate
the output file.

Figure 6-27. FCC Frequency band configuration definition.

47 | /* Define work band */

43 /* #define CONF_BAND CENELEC A */
49 |#define CONF_BAND_FCC

56 /* #define CONF_BAND ARIB */

Check the Table 3-1 for the characteristics of the available ATPLCOUPxxx boards.

6.2.5 Running the PLC application example 1

The Atmel PLC PHY Tester tool is used to control the application running on the SAM4CP16C. As you
can see in Figure 6-28, the two boards are plugged into the same power line. Users have to execute
two instances of the PHY Tester tool — which has been previously installed in the host(s) PC(s) — in
order to enable communication between both boards. Please note that these two instances may or may
not run on the same computer.

Figure 6-28. Atmel PLC PHY Tester concept.

Atmel PLC PHY Tester Atmel PLC PHY Tester

Serial Link
Serial Link

ATSAM4CP16C Device ATSAM4CP16C Device

Power Line

In order to know if the boards were programmed successfully you can check the following:

e The greenled LEDQ, D5, is blinking. This indicates that the PHY Tester Tool application is running
on SAM4CP16C device.

e The LCD screen shows the following message: G3 PTT.

cssonane

You must select the same coupling boards to plug in both SAM4CP16CMB boards. Check
the coupling identifier that you can find in the coupling board.
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These coupling boards must be the proper one for the frequency band you want to
send/receive, otherwise please remove them and connect the proper ones.

By default, SAM4ACP16CMB board sets an ATPLCOUPO007 coupling board, so Voo voltage
of SAM4CP16CMB must be 12 volts. Vop can be regulated to 16 or 12 volts depending on
the J20 jumper position. In this situation, jumper J20 must set. See section 3.5.1 and Figure

A-2 for more information.
Other coupling boards may require different voltage for the class D amplifier (Vop).

Once the application is launched, Starting Window will appear (see Figure 6-30).

Figure 6-30. Welcome instance.

L] Atmel PLC PHY Tester Tool v2.4.2 (=[a] 5 ]
Welcome
Summary
Welcome to Atmel Multiplatform PhyTester, this application allow you to test basic functionality of Atmel PLC products.
Please select the serial port in wich your Atmel board is connected to your PC.
Connection
Serial Port:  [COM1 -]
0 I s W ' BaudRate: (115200 -]
[ FindPorts ] [ Connect ]
Atmel | Enabling Unlimited Possibilities Next >>
J

The first to do is configure the corresponding COM port for each board. In this window we select the
serial connection configuration:

e Selectinthe Serial Port combo box the proper port to connect (see Figure 6-31). As it is explained
in section 6.2.3, communication is by the Enhanced COM (UARTO). If your COM port does not
appear (see section 6.2.3), press Find Ports button.

e Select the BaudRate combo box of 115200 bauds.
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Figure 6-31. Serial port selection.

Connection
Serial Port: COM4 Standard -
COM4 Standard
BaudRate: LCOMS Enhanced )

FindPorts | | Connect |

Once COM port is selected, click the Connect button. As soon as the button is clicked, the button text
will change to Connecting. Then, the application and the board start a process of identification and, after
few seconds, the button text will change to Disconnect. This means that the identification process has
finished. A new tab (Product Information) is appended to the wizard and Next button is enabled allowing
the user to go to the following step of the configuration. See Figure 6-32.

Figure 6-32. Communication enabled.

Help

Welcome Product Information

Summary

Welcome to Atmel Multiplatform PhyTester, this application allow you to test basic functionality of Atmel PLC products.
Please select the serial port in wich your Atmel board is connected to your PC.

Connection

‘ Serial Port:  [COMS Enhanced -
?‘* 1 B j-—a }B ' BaudRate: [ 115200 i ]
LA LES
[ Findeorts | [ Disconnect |
Atmel | enabling Uniimited Possibilities

Click the Next button.

In case the tool cannot establish a communication with the board, the tool shows the following error
message.
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Figure 6-33. Communication error.

-
[ia] Atmel PLC PHY Tester Tool v2.4.2

(=B8] = ]

Help

Welcome | Product

Description

Product Info

Test Selection

Verify Coupling

This tab shows information related with product identification, model of the PCB and information about firmware version.
At the bottom of the tab it's necessary to select a choice between Transmision and Reception test

Product Id:

Model 1d:

i Atmel PLC PHY Tester Tool [

i, Warning! The coupling board plugged in the main board must be the proper one. (1)
Check the coupling identifier that you can find in the coupling board. If current coupling is not the proper

one for binary flashed, please remove it and connect the proper one. Also verify that Vdd is the correct for
the coupling board selected. Otherwise the board could be seriously damaged.

At[neL Enabling Unlimited Possibilities <<prev | [ Next>>

Board is not responding, please check serial port

Click the OK button and press Prev button to get back to Welcome tab. Now press Disconnect button
and check your connections. Either you have not selected the right Enhanced COM port or the board is
not supplied or the downloaded firmware is not the right. After these operations, you can retry to
establish the communication again between the board and the computer.

Once the communication is right, Product Information tab of the PHY Tester tool is shown below in

Figure 6-34.

Atmel
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Figure 6-34. Product Information tab of the Atmel PLC PHY Tester tool.

g = iy

Help

Welcome Product Information l Reception Parameters I Rx Test Parameters I Configuration Summary l TestExecution |

Description

This tab shows information related with product identification, model of the PCB and information about firmware version.
At the bottom of the tab it's necessary to select a choice between Transmision and Reception test

Product Info
Product Id: SAM4C16C G3 CENELEC-A
Model Id: 0x0001
Firmware Id:  0x25010201
Test Selection
© Transmission © Reception
Verify Coupling

(4, Warning! The coupling board plugged in the main board must be the proper one. /1)
Check the coupling identifier that you can find in the coupling board. If current coupling is not the proper

one for binary flashed, please remove it and connect the proper one. Also verify that Vdd is the correct for
the coupling board selected. Otherwise the board could be seriously damaged.

Atmel | enabling Unlimited Possibilities

The Product Information Tab shows basic information of the type of board connected to, and also asks
the user to select the kind of test to be performed.

Showed information is related to the physical layer implemented in the firmware of the board:

e Product ID: it shows a text string that identify the Atmel PLC product (platform).
e Model ID: It is a 16-bit unsigned integer that identifies the model of the board.

e Firmware ID: It is a 32-bit unsigned integer that identifies the physical layer firmware running in
the board.

Now the user has to do a selection depending on whether the user selects transmission or reception
test, different tabs are added. For reception tests, “Reception Parameters” and “Rx Test Parameters”
tabs are added. For transmission tests, “Transmission Parameters” and “Tx Test Parameters” tabs are
added. Finally, independently of the kind of selected test, two more tabs are added: “Configuration
Summary” and “Test Execution”.

This tab remembers you to set the right PLC coupling boards in both SAM4CP16CMB boards and the
proper voltage to use them (Voo selection).

First, we will describe the process to configure a board as receptor and after that we will describe how
to configure the other board as emitter. Selecting the Reception option and clicking the Next button, a
tab appears as the following image (Figure 6-35).
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Figure 6-35. Reception Parameters tab.

P - = > iy

Help
| Welcome Product Information ‘ Reception Parameters ‘ Rx Test Parameters I Configuration Summary l TestExecution |
Description
This tab allow to configure the channel in which board is going to receive the messages. This is the only configuration needed by the PHY
layer in order to receive messages.
Tonal Noise Adaptation
@ Automatic Configuration (©) Manual Configuration
Interval (ms): 60000 Search and Adapt to Noise Disable Noise Filtering
[¥] Delay Noise capture after correct reception Adapt to Target Frequency | Target Frequency (Hz):
ToneMask
@ None
) Default
@) Custom: [Lower frequency ... Higher Frequency]
At[']eL Enabling Unlimited Possibilities

In Reception Parameters tab you can select the tonal noise adaptation and the tone mask feature.

e Tonal noise adaptation. The phy-layer is able to detect tonal noise and configure some input filters
in order to cancel this noise. User can select two modes, Manual and Automatic.

— Automatic Configuration. Hardware is performing noise captures every fixed interval
(configurable). After each capture the hardware selects the proper filtering for the noise
detected. User can configure to only perform the noise captures when hardware is not
receiving. This option is activated by means of Delay noise capture after correct reception
checkbox.

— Manual Configuration. In this mode the hardware only performs noise analysis when user
press Search and Adapt to Noise button. The user is also able to indicate the frequency
where tonal noise is present and the firmware will configure the filters for this noise by
means of Adapt to target frequency button. Finally user can disable noise adaptation using
Disable Noise Filtering button.

e Tone mask. It allows to disable carriers for each symbol as G3 specification says. An array of O
and 1 is shown when selecting Custom mode, there was a digit for each carrier in the current
band plan (CENELEC-A = 36; FCC = 72; ARIB=54), 1 means carrier disabled and 0 means carrier
not disabled. Default option configures the PHY layer to disable the carriers specified in G3
interoperability tests for each band plan. If you do not use the tone mask feature select None.

Click the Next button to continue.

The next tab shows the RX Test Parameters, see Figure 6-36. This tab is where the following reception
test parameters are configured:

e Time Interval (milliseconds): expected interval between frame transmissions.

e Number of Frames: number of frames to be received.

e Message: ASCIl message expected.
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Default parameters (100 ms and 100 frames) are selected.

Figure 6-36. RX test parameters.

I i e S i)

Help

| Welcome | Product i | Reception P: [ Rx Test Parameters | Configuration Summary | TestExecution |

Description

This tab allow to configure all necessary parameters related with a reception test.

Parameters are:
Time Interval : expected interval between frame transmmition
-Number of Frames : number of frames to be received
“Message : ascii message expected

Test Parameters

Time Interval (ms): 100

Number of Frames: 100

Atmel  Enabling Unlimited Possibilities

Click the Next button to continue.

Figure 6-37. Configuration Summary tab.

Help

| Welcome I Product i I Reception P: ] Rx Test Parameters | Configuration Summary | TestExecution |

i i e ooz S S (=l

Description

This tab shows a brief of the configuration fixed in previous steps, at the tab there is a little explanation of how to proceed with the test

Configuration Summary

Parameter

Serial Port COMS5 Enhanced
Test Type RX
Frame Interval (ms) 100

Number of Frames 100

Attention
In order to obtain correct result for the test, please start before Rx board than Tx board

AtmeL Enabling Unlimited Possibilities
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The previous figure, Configuration Summary tab, shows a table where all the configuration parameters
and their selected values are listed. It is recommended to check that all values correspond to the desired
configuration before to continue.

To start the process, click the Start Test button. A new tab is enabled, at first the table is empty because
any frame has been received. Note that there is a timeout to wait the frame reception.

Figure 6-38. Test Execution tab.

, - - B
Help
| Welcome l Product Information I Reception Parameters I Rx Test Parameters | Configuration Summary ‘ TestExecution
Atmel | Enabling Unlimited Possibilities <rev | [[Reswrt

Once the receiver board has been configured, the emitter board must be configured.

Launch another Atmel PLC PHY Tester tool and once the transmission board is supplied and USB cable
connected, configure the corresponding COM port for the board in the Starting Window.

Once COM port is selected, click the Connect button. As soon as the button is clicked, the button text
will change to Connecting. Then, the application and the board start a process of identification and, after
few seconds, the button text will change to Disconnect. This means that the identification process has
finished (Figure 6-39).

Press Next button.
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Figure 6-39. Communication enabled.

Help

Welcome Product Information

Summary

Welcome to Atmel Multiplatform PhyTester, this application allow you to test basic functionality of Atmel PLC products.
Please select the serial port in wich your Atmel board is connected to your PC.

Connection
Serial Port:  [COM6 Enhanced v
LA aeili8al . BaudRate: (115200 -]

Atmel | Enabling Unlimited Possibilities

=)

A new Tab (Product Information) is appended to the wizard and Next button. This time we select in

Product Information tab, the Transmission option test (Figure 6-40).

Figure 6-40. Transmission option selection.

[] Atmel PLC PHY Tester Tool v2.4.2 (=[] = ]

Help

Welcome | Product Information [ Transmission Parameters l Tx Test Parameters I Configuration Summary I TestExecution l

Description

This tab shows information related with product identification, model of the PCB and information about firmware version.
At the bottom of the tab it's necessary to select a choice between Transmision and Reception test

Product Info
Product Id: SAM4CP16C  G3 CENELEC-A
Model Id: 0x0001
Firmware Id:  0x25010201
Test Selection
© Transmission © Reception
Verify Coupling

(4, Warning! The coupling board plugged in the main board must be the proper one. /1)
Check the coupling identifier that you can find in the coupling board. If current coupling is not the proper

one for binary flashed, please remove it and connect the proper one. Also verify that Vdd is the correct for
the coupling board selected. Otherwise the board could be seriously damaged.

Atmel | Enabling Unlimited Possibilities

L

Note the displayed warning message before to select the coupling board and the voltage value, Vpp.

SAM4CP16C-EK Kit User Manual [USER GUIDE]

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015

Atmel



Once the transmission option is selected, click the Next button.

The Transmission Parameters tab appears (Figure 6-41) that allows you to configure the PLC coupling
board plugged and the transmission parameters.

Figure 6-41. Transmission Parameters tab.

- — Bl
Help
| welcome | ProductInformation | Transmission Parameters | Tx Test Parameters | Configuration Summary | Testxecution |
Description
This tab allow to configure all necessary parameters in order to make a transmission
Transmission Parameters
Modiiation Scheme: TiPower:
Modulation Scheme SubBand Idx  SubBand Power
Tone Map: 0x3f Preemphasis: 0% Full_Gain 7
Branch Configuration: Auto %
Tone Mask
@ None
@) Default
@) Custom: | [Lower frequency ... Higher Frequency]
Atmel | Enabling Unlimited Possibilities

The Transmission Parameters tab appears (Figure 6-41) that allows you to configure the PLC coupling
board plugged and the transmission parameters. The transmission parameters are:

Modulation Scheme. Allow to configure differential or coherent modulation scheme.

Modulation Type. Allow to select between BPSK, QPSK, 8PSK and robust BPSK.

Tone Map. Allow disabling sub-bands, it is dependent of bandplan selected. Each band is
activated or deactivated setting to “1“ or “0" in the corresponding bit of the hex array. The different
sub-bands are ordered in the hex array from least significant bit (lower frequency sub-band) to
most significant bit (higher frequency sub-band). For example, in CENELEC-A bandplan 0x01
represents a tone map where only lower sub-band is active, as well as 0x20 is the tone map
corresponding to a tone map with only the higher sub-band active.

Reed Solomon 2" Block. This feature is only available for FCC and ARIB bandplans compiled
firmware, it allows introducing a second RS block as G3-PLC specification tells.

TX Power. Allow to decrease the transmission power in steps of 3 dB.

Branch Configuration. You can select the impedance branch transmission.

Preemphasis. Allow to introduce an attenuation for each sub-band.

In this example we select (Figure 6-41) the following transmission values:

Modulation Scheme. We select Differential.
Modulation Type. We select BPSK.

Tone Map. We select 0x3f.

Branch Configuration. We select Auto.
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e TX Power. We select Full_Gain.
e Preemphasis. We select 0 and Full_Gain.

You can select the tone mask feature. It allows to disable carriers for each symbol as G3 specification tells.
So if you want a tone with null amplitude select Default option for the tone mask parameter specified for
CENELEC-A (36), FCC (72) and ARIB (54). Or Custom if you want to select other range frequencies. If
you do not use the tone mask feature select None.

Click the Next button to continue.

Figure 6-42. TX Test Parameters tab.

~
Help
| Welcome Product Ir i I Tr iSsi s ‘ Tx Test Parameters | Configuration Summary l TestExecution l
Description
This tab allow to configure all necessary parameters related with a tranmission test.
Parameters are:
Time Interval : interval between frame transmmition
-Number of Frames : number of frames to be transmitted
-Message : ascii message to be tranmitted
Test Parameters
Time Interval (ms): 100
Number of Frames: 100
Message: Atmel, Enabling Unlimited Possibilities
Atmel | Enabling Unlimited Possibilities

Following figure (Figure 6-42) shows the TX Test Parameters tab. This tab is where transmission test
parameters are configured:

e Time Interval (milliseconds): desired interval between frame transmissions.
e Number of Frames: number of frames to be transmitted.
e Message: ASCIl message to be transmitted.

These parameters must match the reception test parameters (Figure 6-36) for the test to be successful.
Default parameters are selected. Click the Next button to continue.

The next tab shows a table where all the configuration parameters and their selected values are listed.
It is recommended to check that all values correspond to the desired configuration before continue.
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Figure 6-43. Configuration Summary tab.

Help
| welcome | Productir ion | Transmission F s | TxTests | Configuration Summary | JestExecution |
Description
This tab shows a brief of the configuration fixed in previous steps, at the tab there is a little explanation of how to proceed with the test
Configuration Summary
Parameter Value fs
Serial Port COM6 Enhanced =
Test Type TX =
Frame Interval (ms) 100
Number of Frames 100
Medulation Scheme Differential
Madulatinn Tine RPSK i
Attention
In order to obtain correct result for the test, please start before Rx board than Tx board
Atmel | Enabling Unlimited Possibilities

To start the process, click the Start Test button. A new tab, Test Executions (reports of TX process), will
appear with the frame sent and the TX result of the transmission process.

Now you can observe the transmission and reception process in both Test Executions windows. If
messages are different, the receiver will not recognize them as a valid. If the configured interval and
number of frames are different, the statistics computed at the end of the test may be inaccurate. In both
board’s displays the transmitted/received messages are showed.

During the transmission process the TX led of coupling board is toggled. You can use it to
check if the PLC messages are sent.

When all frames are sent, both Test Executions windows show some statistics, and both board’s
displays show the test results. See the following figures.
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Figure 6-44. Transmission test result.

L) Atmel PLC PHY Tester Tool v.

Help

I Welcome | Product Inf [ issi Tx TestF

I Configuration Summary

TestExecution ;

91 Tx Succesful 196887880 BPSK
92 Tx Succesful 198379378 BPSK
93 Tx Succesful 198609193 BPSK

94 Tx Succesful 198305330 BPSK

95 Tx Succesful 198327335 BPSK

96 Tx Succesful 198490229 BPSK

Tx Succesful 198303227 BPSK

Tx Succesful 198541799 BPSK

Tx Succesful 198428020 BPSK

Tx Succesful 198654316 BPSK

Frame# TxResult RMS_Calc Modulation Type Modulation Scheme Tone Map
MOD_SCHEME_DIFFERENTIAL 0:3f

MOD_SCHEME_DIFFERENTIAL 0x3f
MOD_SCHEME_DIFFERENTIAL 0:3f
MOD_SCHEME_DIFFERENTIAL 0:3f
MOD_SCHEME_DIFFERENTIAL 0:3f
MOD_SCHEME_DIFFERENTIAL 0x3f
MOD_SCHEME_DIFFERENTIAL 03f
MOD_SCHEME_DIFFERENTIAL 0x3f
MOD_SCHEME_DIFFERENTIAL 0x3f

MOD_SCHEME_DIFFERENTIAL 0x3f

Data o~
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie!
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:
Atmel, Enabling Unlimited Possibilitie:

Atmel, Enabling Unlimited I\"ossibilitiez1

] »

'——Frame Error Info
Total Frames Transmitted: 100

Total Bytes Transmitted: 4600

Phy Layer Error Frames: 0

Frames Not Transmitted due to Busy Tx: 0
Frames Not Transmitted due to Busy Channel : 0
Frames Not Transmitted due to Bad Format : 0
Frames Not Transmitted due to Timeout: 0
——Tx Test

Bandplan: CENELEC-A

Modulation Scheme: Differential

Modulation Type: BPSK

Message: Atmel, Enabling Unlimited Possibilities
Frame Symbols: 41

Frame Duration: 34.575 ms

Tx Mean Interval: 107.60 ms

Effective Baudrate (Peak): 9024 bps

Effective Baudrate (Real): 2900 bps

Raw Baudrate (Peak): 42690 bps

Raw Baudrate (Real): 13718 bps

Channel Usage : 32.13%

Atmel | Enabling Unlimited Possibilities

Cancel
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Figure 6-45. Reception test result.

Help

ion Summary ‘ TestExecution I—

| Welcome | ProductIr il I Reception Parameters I Rx Test Parameters I Config

97 BPSK MOD_SCHEME_DIFFERENTIAL 0x3f 60.42
98 BPSK MOD_SCHEME_DIFFERENTIAL 0x3f 60.48
99 BPSK MOD_SCHEME_DIFFERENTIAL 0x3f 60.44
100 BPSK MOD_SCHEME_DIFFERENTIAL 0x3f 60.41

Frame# Modulation Type Modulation Scheme Tone Map RSSI(dBuV) Link Quality (LQI in dB)

18.25

18.25

18.25

18.25

< n

|

Data

Atmel, Enabling Unlimi
Atmel, Enabling Unlimi

Atmel, Enabling Unlimi

Atmel, Enabling Unlimi‘g

»

L e e e

—--—Frame Error Info
Total Frames Received: 100

Total Bytes Received: 4600

Total RS Error Frames: 0

Total Exceptions Errors: 0

Frames Received with Bad FCH CRC: 0
Total Frames Bad Payload : 0

Total Frames Received OK : 100

Atmel | Enabling Unlimited Possibilities

m

Cancel

=1

While tests are executing, a row is added to the top table with information about the frame currently
transmitted/received. The columns that contain these tables are the following.

Table 6-1. Transmission/Reception parameters showed in columns.

Transmission parameters showed

Parameter Description

Parame-
ter

Reception parameters showed

Description

It indicates the number of frame

It indicates the number of frame received. It is

ASCII format.

Frame # transmitted. It is useful to track the Frame #
useful to track the test progress.
test progress.
T timeftemitsine Eeviierine e Modula- |+ ;- dicates if modulation scheme is differential
mission process. If an error occurs, tion
Result - ) or coherent.
a descriptive text will appear. Scheme
. — . . . Modula- — L
Modulation It indicates if modulation scheme is tion It indicates the type of modulation: BPSK,
Scheme differential or coherent. Type QPSK, 8PSK or BPSK_ROBO.
Modulation It indicates the type of modulation: Tone
Tvpe BPSK, QPSK, 8PSK or Ma It indicates active sub-bands in the frame.
yp BPSK_ROBO. P
Tone It indicates active sub-bands in the It indicates the strength of the signal received
RSSI :
Map frame. in dBuV.
Data It shows the message transmitted in Lal It is a parameter that indicates the mean SNR

per carrier (dB).
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Transmission parameters showed Reception parameters showed

It is the interval of time between the

Int-tla-;(val transmission of the current frame Data It is the received info in ASCII format.
and the previous one.
Rx It is the interval of time between the reception
Interval of the current frame and the previous one.
Payload It shows if the content of the frame is correct
Integrity or not.

After all frames have been transmitted/received, or the test has been cancelled, at the bottom of the tab
it will appear a text box with information about the test. First of all, it will appear information about starting
and ending time, this information is measured by the PC application.

After that, there is a section of information called Frame Error information that shows information about
transmitted/received frames and possible errors. Finally another section shows a resume of the
transmission/reception tests, this information contains much information as modulation scheme,
message length, total frame received, ... that is pretty straightforward but other fields must be explained.
For that, please refer to the tool’s embedded help.

Once received the values, you can copy all values to check and analyze them clicking Copy Table button
on the instances, the reception and transmission.

Click the Restart button to start the test again. It does first in the reception instance to avoid “lose” some
frames.

For further information about the tool, please refer to the tool's embedded help (in the menu bar).

6.3 PLC application example 2 — PHY TX Test Console

This example explains how to use the project application called apps phy tx_test console. This
application lets the user to configure a proper setup to perform both EMC emissions and immunity tests
for SAMACP16CMB board. These tests are based on the use of G3 PHY layer with a terminal console
firmware (apps_phy_tx_test_console.bin) that eases the configuration of several transmission
parameters such modulation, data to transmit, tone map, time interval between frames...

Following chapters explain to you how to supply the board, select the UART1 to communicate with the
SAMACP16C, load the firmware and run the application. The setup is shown in the following figure.

Figure 6-46. Boards connection scheme.
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6.3.1 Supplying the boards
Please refer to 6.2.2 in order to know how to supply the SAM4CP16CMB boards.

6.3.2 USB connection

Please refer to 6.2.3 in order to know how to connect the micro USB cable with the SAM4CP16CMB
board. Remember to select the Standard COM Port, UART1. As is commented in section 3.5.5.3, UART
1 is available by USB connector J9.

UART1 CMOS signals are also available in a triple row male connector J16, see Figure 6-24.

6.3.3 Programming the embedded file
We have commented in section 6.2.4 the way to program a board.

Open the IDE tool used, Atmel Studio or IAR Embedded Workbench. Select the project
apps_phy _tx_test_console.atsIn or apps_phy_tx_test console.eww and build it to generate the output
file. Now you can download the file to the board.

Note that kits do not provide a J-Link ARM or SAM-ICE JTAG probe in order to connect to the
user’s host PC and the boards to download and debug the projects.

Remember that the J-Link USB drivers must have been downloaded previously from the Segger
webpage (see section 6.1.4) and they depend on your operating system.

Remember that, every PHY example project is contained in the following Software folder:
“ISoftware/G3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_sam4cplecmblthirdparty\g3\
phy\atpl250\apps”.

And also you can find all of them in the workspace project, sam4cpl6¢c_PLC_examples,
which is contained in following Software folder:

“\Software\G3_va.b.c_ CENELEC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\
apps\apps_workspace_sam4cpl6c_samdcplécmb\”.

6.3.4 Running the PLC application example 2

As the PLC application example 1, boards are plugged to the mains, see Figure 6-46. Users have to
execute an instance of the serial interface tool — which has been previously installed to the host PC —in
order to enable communication between both boards. Please note that these two instances may or may
not run on the same computer.
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Figure 6-47. PHY TX Test Console concept.

Serial Interface tool, e.g.:
Putty

Serial Link

ATSAMA4CP16C Device

Serial Interface tool, e.g.:
Putty

Serial Link

ATSAM4CP16C Device

Power Line

For this example a serial interface tool is required. HyperTerminal is not installed on Windows 7. You
can use a PUTTY terminal instead. Once you have the serial terminal in your computer, open putty.exe
and connect to the COM port number assigned to the micro-B USB cable (see Figure 6-24). As is
commented in section 3.5.5.3, UART 1 is available by USB connector J9. UART1 CMOS signals are
also available in a triple row male connector J16, see Figure 6-24. Remember to select the Standard

COM Port, UART1.

Figure 6-48. COM Port selection.

File Action View Help

= @ E HE & F &b

| = Devie Manager e

4 ZARDT0024
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>-{8 Computer

b =y Disk drives

B Display adapters

> -ty DVD/CD-ROM drives
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> - IDE ATA/ATAPI controllers
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>-ﬂ Mice and other pointing devices

» B Monitors

4 & Network adapters

H &F Broadcom NetLink (TM) Gigabit Ethernet
%3 Cisco Systems VPN Adapter for 64-bit Windows
» Bl Portable Devices

.Y Ports (COM &LPT)

i 1.7% Silicon Labs Dual CPZ10x USE to UART Bridge: Enhanced COM Port (COM4)

l "7 Silicon Labs Dual CP210x USB to UART Bridge: Standard COM Port (COM3) |

b A Processors

5% Sound, video and game controllers
>-{M System devices

b s Universal Serial Bus controllers

Category:
(=) Session [

Basic options for your PuTTY session

Close window on exit:
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TM L‘oglging Specify the destination you want to connect to
=R
0 7""&03 . Serial e Speed
- Bell com7 115200
- Features Connection type:
=) Window () Raw () Telnet () Rlogin (©) SSH @) Serial
gppea@nce r Load, save or delete a stored session
- Behaviour
Saved Sessions
Default Settings Load
aragonproject
- ko
Save
=
- Rlogin
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Serial

@ Only on clean exit

[

Open | Cancel |

Set 115200 in the Speed field. In the Serial Category, change the Flow Control to None. The other fields
should already be correctly configured. Finally, click Open.
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Figure 6-49. PUTTY Configuration instance.
@ PuTTY Reconfiguration

e

Category:

(- Session [ Options controlling local serial lines ‘
i *logging
=)~ Terminal "

Keyboard Speed (paud) 115200
- Bel Data bits

i-- Features

- Window Stop bits

8
1
i~ Behaviour
. Translation Flow control XON/XOFF =

- Selection
‘... Colours
=)~ Connection
‘... Serial

Configure the serial line

| oy J[ Concel |

In order to know if the boards were programmed successfully you can check the following:

e Once board is supplied, leds LEDO and LED1 blink several times.

e After that, green led D5, LEDO, is blinking. This indicates that the PHY TX Console application is
running on SAM4CP16C device.

e The LCD screen shows the following message: G3 PTX.

Figure 6-50. LCD message with PHY TX Console binary programmed.

In the Terminal window, main menu is displayed (press Reset button in case board has been supplied
previously to connect USB cable).
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Figure 6-51. Main menu.

&P COM7 - PuTTY = B X

The description of each field is the following:

e 0: Select TX level — 0 is 0dB of attenuation and every step increments the attenuation in 3dB. In
the current firmware the maximum attenuation value is 10 (30dB). The value could be from 0 to
31 because it is defined in the G3 specification.

e 1: Select Modulation Scheme: In this example we choose 3 that is Differential Robust.
e 2: Select time period between messages to transmit (us). 5400us in this example.

e 3: Select data to transmit. In this example we choose Random Data and 133 bytes. This value
(133 bytes) is the maximum for Robust mode in CENELEC.

e 4: Select TX tone map. Ox3F in this example.

e b5: Select TX preemphasis. 0 in this example.

e Vv: View Tx configuration values. Press v key of keyboard to check default configuration.

e e: Execute transmission application. Press e key in the keyboard to begin transmission and

reception mode in both boards. And press x key of keyboard to stop the transmission process.

Default configuration is configured for ready for EMC tests:

e TXlevel: 0. 0dB of attenuation.

e Modulation/Scheme: 3. It means Differential Robust.

e Time period: 5400. 5400us between messages to transmit.

e Data: 1. It is Random Data to transmit of 133 bytes. 133 bytes is the maximum for Robust mode
in CENELEC.

e TXtone map: Ox3F.
e TX preemphasis: 0.
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Figure 6-52. Default configuration menu.

Note: In phy tx test console.C file is the possible values of the parameters from main menu fields.

Figure 6-53. Transmission messages.

[ com7 - purry E=SEEE)

8 to transmit (us

Default configuration is configured for ATPLCOUPO0Q7 coupling board for differential modulation scheme
in Robust mode with 133 data bytes length and 5.4 milliseconds time interval between PLC frames.
During the transmission green led (LEDO) is blinking indicating test is running. And the yellow led, PLC,
on ATPLCOUPOO7 board blinks every time a PLC frame is sent. In the reception board, the red led
(LED1) blinks in every PLC frame reception.
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Figure 6-54. Menu when transmission is stopped.

. : ~
£B COM7 - PuTTY. [E=NEER

m

In case the configuration default has been changed, the board keeps the configuration unless power
shutdown. If board is reset while keeping power supply on, it will restart the configuration mode after
start-up.

6.4 PLC application example 3 — PHY Sniffer

In this example, we present you the G3 PHY Sniffer project, apps_phy_sniffer_tool. G3 PHY Sniffer
project is able to monitor data traffic on the G3-PLC network by means of an SAM4CP16CMB board
and the PC application, ATPL Multiprotocol Sniffer. For this example, only one SAM4CP16CMB board
is required and obviously a G3 network to be tracked.

The circuitry in the coupling boards has an influence in the reception itself. As a
consequence, each coupling board is intended to be used in their corresponding frequency
band(s) only. The application behaves properly when this correspondence is maintained.

Figure 6-55. SAM4CP16CMB board connection scheme.

Atmel G3 PHY Sniffer

..........
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6.4.1 ATPL Multiprotocol Sniffer tool Installation

To install ATPL Multiprotocol Sniffer tool in a Windows Operating System, execute the provided installer
in the PCTools folder “\PCTools\ATPL_Multiprotocol_Sniffe\ATPL_Multiprotocol Sniffer vX.Y.Z.exe”
and follow the installation wizard. The installer wizard should open. To follow the installation, click Next.

Figure 6-56. ATPL Multiprotocol Sniffer installation process, slide 1.

/7 Atmel ATPL Multiprotocol Sniffer Se‘th_IEIEIg

Choose Users —
Choose for which users you want to install Atmel ATPL Multiprotocol Sniffer. (,)7 ‘

Select whether you want to install Atmel ATPL Multiprotocol Sniffer for yourself only or for all
users of this computer. Click Mext to continue.

@ Install for anyone using this computer

) Install just for me

[ Mext = ] [ Cancel

Select the users’ permissions and click Next.

Figure 6-57. Installation process, slide 2.
/7 Atmel ATPL Multiprotocol Sniffer M_Elﬂlg

Welcome to the Atmel ATPL
Multiprotocol Sniffer Setup Wizard ‘

This wizard will guide you through the installation of Atmel
ATPL Multiprotocol Sniffer.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue,

< Back ][ Mext = ] [ Cancel

Click Next to continue.
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Figure 6-58. Installation process, slide 3.
Atmel ATPL Multiprotocol Sniffer Setup

License Agreement Reiny
Please review the license terms before installing Atmel ATPL Multiprotocol Sniffer. Y

Press Page Down to see the rest of the agreement.

=VALUATION LICENSE AGREEMENT

[l »

IT IS IMPORTANT THAT YOU READ THIS AGREEMENT CAREFULLY AND COMPLETELY.

This Evaluation License Agreement ("Agreement”) is a legally binding agreement between
'your employer {"Licensee”) and Atmel Corporation (“Atmel”). By dicking the "I Accept”
button or by downloading, installing or using any of the software available for download
(Licensed Software™), you are indicating that you are binding Licensee to the terms of

this Agreement, and that you are duly authorized by Licensee to do so. If you are not
authorized to bind Licensee to the terms of this Agreement, or if Licensee does nat

agree to be bound by all of the terms of this Agreement, do not dick the T Accept” -

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install Atmel ATPL Multiprotocol Sniffer.

Mullsoft Install System vz, 46

[ <Back || 1Agee | [ cancel |

Read and accept terms and conditions expressed in the End User License Agreement. Click | Agree to

continue.

Figure 6-59. Installation process, slide 4.
171 Atmel ATPL Multiprotocol Sniffer Setup

Choose Components 'y

Choose which features of Atmel ATPL Multiprotocol Sniffer you want to install. 9

Check the components you want to install and unchedk the compeonents you don't want to
install. Click Mext to continue.

. Description
Select components to install: Atmel ATPL Multipratocol - P

Position your mouse
ower a component b
see jbs description.

Space reguired: 51.4MB

Mullsoft Install System vz, 46

[ <Back |[ Mext> | [ cancel

Click Next to install the component selected.
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Figure 6-60. Installation process, slide 5.

gt i S Eloise

Choose Install Location —
Choose the folder in which to install Atmel ATPL Multiprotocol Sniffer. (;)

Setup will install Atmel ATPL Multiprotocol Sniffer in the following folder. To install ina
different folder, dick Browse and select another folder. Click Install to start the installation.

Destination Folder

-ogram Files (x86)\Atmel\ATPL Multiprotocol Sniffer_1.1.7

Space required: 51.4MB
Space available: 302.6GE

[ < Back ][ Install ] [ Cancel ]

Setup will install the program in the Destination Folder. To install in a different folder, click Browse and
select your destination folder. Click Install to start the installation process.

Figure 6-61. Installation process, slide 6.
|71 Atmel ATPL Nhh-igrotocol Sniffer Setup _ o= o S

Completing the Atmel ATPL
Multiprotocol Sniffer Setup Wizard ‘

Atmel ATPL Multiprotocel Sniffer has been installed on your
computer.

Click Finish to dose this wizard,

Click Finish.

Now the program is installed in your computer and a shortcut should have been created in your desktop.

6.4.2 Supplying the boards
Please refer to 6.2.2 in order to know how to supply the SAM4CP16CMB board.

6.4.3 USB connection
Please refer to 6.2.3 in order to know how to connect the micro USB cable with the SAM4CP16CMB
board.

6.4.4 Programming the embedded files

We have commented in section 6.2.4 the way to program a board. To program the board as PLC sniffer,
process will be the same: building the IDE project and downloading into the board.
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Open the IDE tool used, Atmel Studio or IAR Embedded Workbench. Select the PHY sniffer tool project,
apps_phy_sniffer_tool.atsIn or apps_phy_sniffer_tool.eww, and now build it to generate the output file.

Note that kits do not provide a J-Link ARM or SAM-ICE JTAG probe in order to connect to the
user’s host PC and the boards to download and debug the projects.

Remember that, every PHY example project is contained in the following Software folder:
“/Software/G3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_samdcpl6cmblthirdparty\g3\
phy\atpl250\apps”.

And also you can find all of them in the workspace project, sam4cpl6¢c_PLC_examples,
which is contained in following Software folder:
“\Software\G3_va.b.c_CENELEC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\
apps\apps_workspace_sam4cpl6c_samdcplécmb\”.

Remember that the J-Link USB drivers must have been downloaded previously from the Segger
webpage (see section 6.1.4) and they depend on your operating system.

As we commented in a previous section, every coupling board is intended to be used in
their corresponding frequency band(s) only. By default, sniffer project of
G3_va.b.c_CENELEC folder is compiled for ATPLCOUPOO07 board. This means that only
CENELEC-A frequency band is supported.

If you are going to use ATPLCOUPOQ06v1 coupling board, you must use G3_va.b.c_FCC folder to build
the PHY sniffer project with the correct configuration. For that, open the IDE tool used, Atmel Studio or
IAR Embedded Workbench. And open the PHY sniffer project application, apps_phy_sniffer_tool.atsIn
or apps_phy_sniffer_tool.eww.

After that, you can select the file conf project.h, that it is in the PHY project directory,
“\Software\G3_va.b.c_FCC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\phy\atpl250\apps\
phy_sniffer_tool\sam4cpl6c_samdcpl6cmb”, find the define function to select the coupling board
configuration (see Figure 6-27) and check the frequency band name is the desired. So build to generate
the output file.

Figure 6-62. FCC Frequency band configuration definition.

47 | /* Define work band */

43 /* #define CONF_BAND_CENELEC_A */
49 #define CONF_BAND_FCC

58 |/* #define CONF_BAND_ARIB */

Check the Table 3-1 for the characteristics of the available ATPLCOUPxxx boards.

In order to know if the boards were programmed successfully you can check the following:

e The green led D5, LEDO, is blinking. This indicates that the PHY Sniffer application is running on
SAM4CP16C device.

e The LCD screen shows the following message: G3 SNF.
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Flgure 6-63. LCD message W|th PHY Snlffer binary programmed.

6.4.5 Running the PLC application example 3

As you can see in Figure 6-55, the boards are plugged into the same power line. Users have to execute
an instance of the ATPL Multiprotocol Sniffer tool — which has been previously installed in the host PC
— in order to enable communication between the sniffer board and the PC. The ATPL Multiprotocol
Sniffer tool is used to monitor data traffic on the network. You can also use the ATPL Multiprotocol
Shniffer tool to monitor the PLC messages which they do not belong the G3 standard then the messages
will be showed in red colour and without PduType.

The main window of the Sniffer PC interface is shown in Figure 6-64.

Figure 6-64. ATPL Multiprotocol Sniffer tool window.

File Configure Capture View About

Ready Silicon Labs Dual CP210x USB to UART Bridge: Enhanced COM Port (COMS]), B115200 DB File: ATPL-log, APPEND

Once the application is launched, the COM port for the board needs to be configured. The COM port
selection window is available by choosing Configure>Input (Ctrl+l). A new window Input Settings will
appear as shown in Figure 6-65.

First of all, select the Power Line Communication protocol, in this case G3. After that select the COM
port and set the speed. The default port is UARTO (enhanced COM port) and the speed for this
application is 115200 bauds. Also, this tool is able to connect to a remote device through the TCP/IP
protocol.
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Figure 6-65. Input Settings window.

oo
Protocol
Connection
@ serial Port Input () TCPJIP Input

Serial Port

C
HSiIicon Labs Dual CP210x USB to UART Bridge: Enha = ]]lnszoo

TCP/IP Connection

P:1370.0.1 Port: | 5pg20

Database Initialization Script

The database file to store the traffic must be configured. If output logs are required and the location to
store these choose Configure>Database... (Ctrl+D). A new window Database Settings will appear as
shown in Figure 6-66, select the file name and click OK button. Database files can hold longer logs
without having to split them in pieces. Also log stored files can be opened to review the file. The three
options when you create a log database depends on if you want to keep the previous data or not. And
it is possible to build your own scripts (for example, in Python) to analyze the data.

Besides of the log database, there are a set of scripts supplied along the ATPL Multiprotocol Sniffer that
prepares the database to be able to decode all the messages sent in the Interoperability tests defined
by the G3-PLC Alliance.

Figure 6-66. Database Settings window.

i B
= ovben sy, L
g 3

@ Append () Owverwrite () DateTime Suffix

[ OK ][ Cancel ]

At this point, the tool is ready to start capturing data. If board is not powered, this is the point to supply
it.

Click on the menu Capture>Start to begin logging data. If tool establishes the communication with the
COM port of the SAM4CP16CMB, the status bar at the bottom of the window will show the current setup
and status of the tool. On a G3 network the main window will look like as the Figure 6-67. Main window
displays a table with the current log. It is updated in real time as frames are received from the hardware
sniffer.
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Figure 6-67. ATPL Multiprotocol Sniffer tool main window.

- ATPL Multiprotocol Sniffer Log: C:/00-TRABAJO/DATA/G3/DISCOVERY_BOOTSTRAP.rebuild.sql = S|
View  Export
Hexa View & X | Packet View g %
00 01 02 03 04 05 06 07 08 09 OA 0B OC OD OE OF Field Value
109 00 OC 61 C& CA 1D 78 00 00 B8 77 €6 55 44 33 ...a...x...wfUD3 Frame # 3
ModType 4
222 11 40 02 10 00 11 22 33 44 55 66 77 88 00 00 ".@...."3DUfw... ModScheme 0
Delimiter Type 1
3 F5 89 .. Symbols # 0
Timestamp 2014-09-24T13:51:4
Lqr
Duration 68.11
Defta 3040.083
ALY 00 0
Sequence Number 0xCA
idframe TimeStamp oT LQI Duration Delta TMR CC CAP LastSegment SegmentCount PduType  Cmdlype  SecurityEn Securitylevel SecFrameCounter Keylndx SeqNumber D Dest PAN 0:781D
1 2014-09-2.. SOFNORESP 0 4309 100.. 0 0 0 1 0 CMD  BREQ 0 - - - 0xC9 2 Dest Address 020000
SrcPAN 0:781D
2 2014-09-2.. SOFNORESP 0 48477 428..0 0 0 1 0 BCN - 0 - - - 0:80 0 Sre Address 0x112233445566778
3 RESP 0 204... LBP_JOINING - - - Security Enabled 0
a i 4 PduType 1
Datalength 12
Data
6 2014-09-2.. ACK 0 1528  10..- - - - - - - = = = - 0:00 - 4 1BP LoWPAN Bootstrap]
7 201409-2.. SOFRESP 0 104077 387..0 0 0 1 0 DAT  LBP_CHALLENGE 0 - - - 0:02 3 I ’ 3
ode
8 2014-09-2.. ACK 0 152 2. - - - - - E - - - E - 0:00 - EULGE  DuBBTIE6S5H433221
9 201409-2.. SOFRESP 0 14317 181..0 0 0 1 0 DAT  LBPIOINING 0 - - - 0xCB 2
10 2014-09-2.. ACK 0 15117 166, - - 0:00
u 2014-09-2... SOF_RESP 0 173577 265.. 0 0o 0 1 o DAT LBP_CHALLENGE o - - - 0:03 3
12 2014-09-2... ACK 0 1529 597.. 0:00
13 2014-09-2... SOF_RESP 0 12649 166... 0 0o 0 1 o DAT LBP_JOINING o - - - 0xCC 2
1 2014-09-2.. ACK 0 1517 15l - - 0:00
15 2014-09-2.. SOFRESP 0 70717 275..0 0 0 1 0 DAT  LBPACCEFTED 0 - - - 004 3
16 2014-09-2.. ACK 0 1529 48l - - - - - - - - - - - 0:00 - T D
< m ] r =

The capture window has a tool bar with two commands (see Figure 6-68):

e Pause command will stop the update of the scroll view, while the logging process will continue.
e To restart showing the live stream of PDUs, click Play button.

Figure 6-68. Tool bar.

Main window displays a table with the current log. It is updated in real time as frames are received from
the hardware sniffer. The data shown are: idFrame, Timestamp, ModType, ModScheme, Delimiter Type,
Symbols, SNR, RSSI (in db/uV), Duration, Delta, Tone Map Request, Contention Control, Channel
Access Priority, Last Segment Flag, SegmentCount, PduType, CmdType, SecurityEn, SecurityLevel,
SecFrameCounter, Keylndx, SegNumber, PanldCompression, DestAddrMode, SrcAddrMode,
DestPAN, SrcPAN, DestAddress, SrcAddress, Length, Pdu, headerLen and payloadLen.

While the PLC traffic is logged into a database, the software tries to infer the PLC network structure and
status as seen by the PAN coordinator. This information is shown in several docking views. They are
available on the menu View:

e Hexa view shows the hexadecimal display of the selected frame in the main view.

e Packet view shows the disassembled data of the selected frame in the main window. All the
specified fields on the G3 specification are shown.

o Filter view allows selecting the frames shown in the main view table.

To uninstall the ATPL Multiprotocol Sniffer tool from your computer, go to Start>All
Programs>ATMEL>ATPL Multiprotocol Sniffer vX.Y.Z>Uninstall.

For further information, please refer to the tool’s embedded help (in the menu bar).
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6.5 Introduction to G3-PLC Stack

PLC is a medium with such special characteristics (asymmetry, noise variation in time, etc.) that make
it a hostile environment for successful communication when users are not familiar with these issues.

On the PHY level, G3-PLC is based on the OFDM modulation technique. OFDM can efficiently utilize
limited bandwidth channels allowing the use of advanced channel coding techniques. This combination
facilitates a very robust communication over a power line channel in presence of narrowband
interference, impulsive noise and frequency selective attenuation.

OFDM supports differential modulations (DBPSK, DQPSK, D8PSK and DBPSK in robust mode) and
coherent modulations (BPSK, QPSK, 8PSK and BPSK in robust mode) to use in CENELEC, FCC and
ARIB bandplans (10 kHz - 490 kHz). In G3-PLC, convolutional, Reed-Solomon and CRC16 coding
provide redundancy bits allowing the receiver to recover lost bits caused by background and impulsive
noise. And also other techniques as adaptive tone mapping, notching and modulation provide very
robust power line communications.

On top of the PHY layer, the G3-PLC MAC and ADP layers provide the conditions for fast and secure
communication by use of advanced routing techniques through hopping via devices in the network. The
ITU-T G.9903 data link layer specification comprises these two layers:

e The MAC layer based on IEEE 802.15.4.
e The adaptation layer based on IETF RFC 4944,

In the following sections there are basic overviews of the Atmel libraries used and the description of the
whole system integration (FreeRTOS, G3-PLC stack and the SAM4CP16C) in a G3 project using the
ASF structure.

6.5.1 FreeRTOS

FreeRTOS is a real-time kernel (or real-time scheduler) on top of which Cortex-M3/M4 microcontroller
applications can be built to meet their hard real-time requirements. It allows Cortex-M3/M4
microcontroller applications to be organized as a collection of independent tasks to be executed. The
kernel decides which task should be executed by examining the priority assigned to each by the
application designer. In the simplest case, the application designer could assign higher priorities to tasks
that implement hard real-time requirements, and lower priorities to tasks that implement soft real-time
requirements. This would ensure that hard real-time tasks are always executed ahead of soft real-time
one.

Thanks to the FreeRTOS scheduler we are able to optimize G3-PLC code and memory usage. Although
the SAM4CP16C has two cores, we will run the G3 project only in the core 0.

6.5.2 ASF Integration

As it was explained before, ASF has a defined structure. ASF root folder contains the common/ directory,
the sam/ directory and the thirdparty/ directory. The components contents of thirdparty directory are
showed in the following figure. That is the way to integrate the whole platform in this structure
(SAM4CP16CMB, SAM4C, PLC, G3 and FreeRTOS).
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Figure 6-69. SAM4C & G3 Integration in thirdparty folder.
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We integrate the different parts according to the ASF structure:
e Boards: The SAM4CP16CMB board hardware mapping is defined here.
e Drivers: The drivers for the SAM4C Family.
e Services. We offer the PLC modem as a service.
e  ThirdParty: We add in this point the G3 and FreeRTOS libraries.

It happens that the last version of the Atmel Software Framework provided in the web link at
this moment- release ASF3.27 (September 2015) — does not coincide with the PLC libraries
of the projects from the kit's Software folder. PLC libraries of the kit are an above version
that ASF.

You can check the versions of G3-PLC software provided in the kit in g3_stack version.h
file. Also, PHY layer version in atpl250_version.h file.

Take into account, previous to download futures releases of ASF, if it is supported by these
kit's version boards.

In case you do not know the ASF version downloaded in Atmel Studio, go to Help>Atmel Studio. Select
in the combo box of the new window the component: Atmel Software Framework. After that, all the

versions installed are showed.

6.5.3 Atmel G3-PLC Stack Structure

The Atmel G3 firmware stack follows a layered approach based on G3-PLC specification. The Figure 6-
70 shows the G3 stack’s architecture. The stack modules are from the bottom up:

e PHY Layer.

e MAC Layer.

e Adaptation Layer.
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Figure 6-70. G3- PLC stack.
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The Atmel G3 stack is able to run on a system with an OS (the OS Wrapper is an abstraction layer so
different OSS can be used), or without it, running in microcontroller mode.

The OS intends to transform the microcontroller-mode operation into a task-mode operation typical of
operating systems. In order to do that, it creates and manages a single task where all active layers and
interfaces are included. The user does not need to take care of controlling how the G3 stack is running
and can create their applications normally. The current implementation of the OSS is based on
FreeRTOS but the user could modify it appropriately to use any other RTOS.

The Atmel G3 stack is according to the following architecture:

e PHY Layer. PHY layer is in charge of frame transmission and reception, this layer will be interrupt
driven with events coming from PLC transceiver peripheral. Interrupt events will occur while
transmitting and receiving frames. Apart from these events, PHY layer will implement entry
functions in order to transmit a frame using the PLC modem, and to access the PHY Information
Base (PIB) to read, write, or modify parameters.

e PAL. This layer abstracts the interface of the SAM4CP16C PHY Layer developed by Atmel and
provides an interface compliant with the G3 PHY and MAC layers, and is in charge of
communicating both layers properly. It will implement primitives to inform the MAC layer of events
coming from PLC. Apart from these tasks, PAL will directly address function calls from MAC to
transmit a frame to PHY layer. The same will occur with MAC calls to PLME functions, which will
be directly addressed to PHY functions related to PIB access.

e MAC and Adaptation Layers. These layers will run together in 1 OS task (if OS is used), along
with the PHY layer. MAC layer will access PHY layer using an intermediate PAL described above.
It will implement the API defined in G3-PLC specification for the upper layer (Adaptation Layer).
MAC implements the following tasks:

— Channel access with CSMA-CA.

— High and normal priority.

— Segmentation of big packets.

— Segment acknowledgement and retransmission of lost segments.
— Network scan.

— Transmission robustness management.

e Adaptation layer will access MAC layer below, and will implement the API defined in G3-PLC
specification for the upper layer (IPv6 Layer) so any implementation of IPv6 can be used above
it. ADP implements the following tasks:

— Handles the device authentication and encryption key distribution.
— IPv6 headers compression / decompression.
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— Fragmentation / reassembly of the IPv6 packets.

— Controlling broadcast / multicast propagation.

— Routing a message into the network.

— Discovery and maintenance of the routes into the network.

e |Pv6, UDP and DLMS Layers. These layers are generic and not directly related to G3-PLC
protocol. These layers will run each one on a separate OS task (if OS is used), to make it possible
to extract or insert any of them on the stack. Also for this purpose, each layer will provide the API
defined in the corresponding standard.

e  Serialization Layers (Universal Serial Interface, USI). Serialization will be available on PHY layer.
Serialization of PHY layer will act as the PAL layer, but communicating with a Serial Port Service,
instead of the MAC. PHY Tester and PHY Sniffer projects use this serialization to communicate
with the PC.

The following figure shows the architecture of the Atmel G3 software stack to be placed over the
SAMA4CP16C platform.

Figure 6-71. Atmel G3 software Stack overview.
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For more information about the Atmel G3 Firmware Stack see the doc43081 and the G3-PLC
specification.

Now we are to show the Atmel G3-PLC implementation using one of the provided examples. Open the
G3 workspace for SAM4CP16C platform, SAM4CP16CMB_PLC_examples. For that, select your IDE
tool and select the workspace according to your IDE in the Software folder:
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“.ISoftware/g3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_sam4cpl6cmb\thirdparty\g3\apps\apps__
workspace_sam4cpl6c_sam4cplécmb”.

Once you have loaded the workspace, open the APPS DLMS EMU COORD_APP project. Atmel
provides a G3 PLC library with some basic PAN Coordinator features, such as creating the Network and
accepting all Network Join from the Devices. This way, it is possible to build a network so data can be
exchanged.

This is just a basic implementation for demonstration purposes, and it cannot be taken as
the reference to build a complete PAN Coordinator.

In order to ease the integration of the user app code into the Atmel G3-PLC firmware stack, the stack
just requires developing some user functions and files accordingly to the structure of the firmware stack.
The Figure 6-72 shows the G3 project structure for the SAM4CP16C according to the ASF structure.

Workspace package is divided in 3 folders, common, sam and thirdparty. Common and sam contain
generic drivers and components for Atmel microcontrollers.

Thirdparty folder contains CMSIS folder, where ARM Cortex interface is located, freertos folder, where
the porting of freertos to Atmel microcontrollers can be found, and g3 folder, where all the G3-PLC stack
and example applications code is located.

Under g3 folder, there is basically one folder for each layer of the G3 stack, plus IPv6, plus applications
(apart from some auxiliary folders).

Two different apps folders can be found, one under phy/atpl250, where PHY example applications are
located, and one directly under the g3 folder, where example applications involving the whole stack can
be found, apart from the generic workspaces which contain all the previously mentioned projects.

Any of these apps folders contain the projects for the supported compiles, so user can open, inspect,
and compile them.
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Figure 6-72. G3-PLC library structure.
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Note: This figure is only to give a general idea about the distribution of the folders and the libraries in
a basic G3-PLC project.
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Where G3 folder contains:

e adp folder contains the Adaptation layer API.
e bootstrap folder contains the bootstrap process.
e |pv6 folder contains the IPv6 stack.
e libs folder contains the MAC and ADP library.
e mac folder contains the MAC layer API.
e oss folder is the Operative System Support.
e phy folder is the Physical layer.
e pal folder is the Physical Abstraction layer.
In the Atmel G3-PLC stack structure there are some important configuration files where the user can

select some options that modify the behavior of the project. Note that these configuration files contain
the proper configuration for the provided boards of the kit and user does not need to change them.

e PHY configuration files (see Figure 6-73). In the g3 folder,
“/Software/g3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_samdcpl6cmb/thirdparty/g3/phy/at
pl250/module _config”, there are two files: atpl250db_conf.c and atpl250db_conf.h. Note that
these files allow to the user to configure PHY layer initial parameters. Thus, user can adapt the
PHY layer to any hardware designed.

e Project configuration files (see Figure 6-73). There are several files:
— conf_board.h to configure the SAM4CP16CMB board features (watchdog, drivers,
peripherals...).
— conf_buart_if.h to configure the number and buffers’ size of the UARTSs.
— conf_busart_if.h to configure the number and buffers’ size of the USARTSs.
— conf_clock.h to configure the SAM4CP16C clock.
— conf_oss.h to configure the system as microcontroller mode or FreeRTOS OS.
— conf_platform.h to configure the timers parameters and power down detection.

— conf_pplc_if.h to configure PPLC interruption. According with the hardware used, it is
necessary to define de SPI configuration selected for the communication with the G3
modem, the interruption and reset signals defined.

— conf_project.h to configure the work band used and the embedded sniffer.
— conf_slcdc.h to enable the LCD signaling.
— conf_uart_serial.h to configure the serial UART.
— conf _usi_if.h to configure the number of Ports/Protocols managed by USI.
— FreeRTOSConfig.h to configure the Generic FreeRTOS peripheral control functions.
In addition to these configuration files, there are four important files more (for this project):
e dims _emu_coord.c. Itis a file for the final user for the cycles application with the init and process
defined.

o dims _emu_coord.h. It is a header file with the cycles application functions. Also, it contains some
configuration constants which can be changed by the user depending on the number of Devices
connected and the number of hops required to reach Coordinator is complex setups are used.

e asf.h. It includes all the API header files required by ASF for the modules that you use in your
project. It is automatically updated every time you add or remove drivers from your project.

e main.c. In this file, the G3-PLC stack is initialized and the processes of the main infinite loop.

84  SAMA4CP16C-EK Kit User Manual [USER GUIDE] Atmel

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015



6.6

Figure 6-73. Configuration files in IAR and AS.
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PLC application example 4 — PLC Network

In this chapter the example proposed is used to show the capabilities of the SAM4CP16C in a network
of smart devices. One SAM4CP16CMB board acts as a Coordinator, i.e. the device that controls the
whole network, whereas the other one SAM4CP16CMB board acts as Device.

Atmel provides a G3 PLC library with some basic PAN Coordinator features,
APPS_DLMS_EMU_COORD_APP application, such as creating the Network and accepting all Network
Join from the Devices. This way, it is possible to build a network so data can be exchanged.
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This is just a basic implementation for demonstration purposes, and it cannot be taken as
the reference to build a complete PAN Coordinator.

APPS DLMS EMU_COORD_APP and APPS DLMS EMU_DEV_APP are template applications
intended to hold the application code developed by the user along with the Atmel G3-PLC Stack. So the
user can integrate his application code in the firmware package delivered by Atmel. They are provided
for IAR and Atmel Studio

Following sections explain to you how to install the PC tool, select the projects, supplying the boards,
select the COM ports to communicate with the SAM4CP16C and run the application.

6.6.1 Supplying the boards
Please refer to 6.2.2 in order to know how to supply the SAM4CP16CMB boards.

6.6.2 USB connection

Please refer to 6.2.3 in order to know how to connect the micro USB cable with the SAM4CP16CMB
board.

6.6.3 Programming the embedded files

It is commented in section 6.2.4 the way to program a board. To program the board as Coordinator and
Device, process will be the same: building the IDE project and downloading into the board.

Open the G3 workspace for SAM4CP16C platform, SAM4ACP16CMB_PLC_examples. For that, select
your IDE tool and select the workspace according to your IDE in the Software folder:
“./Software/g3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_sam4cpl6cmb\thirdparty\g3\apps\apps_

workspace_sam4cpl6c_sam4cpl6écmb’.

Once you have loaded the workspace, open the APPS DLMS EMU_ COORD_APP project. This project
is the Coordinator project. Now you can build and download to the SAM4CP16CMB board.

After that, open the APPS DLMS EMU _DEV_APP project. This project is the Device project. Now you
can build and download to the other SAM4CP16CMB board.

Note that kits do not provide a J-Link ARM or SAM-ICE JTAG probe in order to connect to the user’s
host PC and the boards to download and debug the projects.

Remember that, template application project is contained in the following Software folder:
“ISoftware/G3_va.b.c_ CENELEC/g3.workspace.sam4cpl6c_sam4cpl6cmblthirdparty\g3\
apps\template_app\sam4cpl6c_samdcplécmb_lib/”,

And also you can find it in the workspace project, sam4cpl6c_PLC_ examples, which is
contained in following Software folder:

“\Software\G3_va.b.c_ CENELEC\g3.workspace.sam4cpl6c_sam4cpl6cmbithirdparty\g3\
apps\apps_workspace_sam4cpl6c_samdcpl6écmb\”.

Remember that the J-Link USB drivers must have been downloaded previously from the Segger
webpage (see section 6.1.4) and they depend on your operating system.

Previously to build and download to the boards several issues have to been taken into account:

e Frequency band to use (coupling board).

e  Operation modes (Operation System Support).
e Initializing FW stack.

o Developing user application requirements.
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e Modify the configuration files according to user needs.
Next sections explains part of these points to get a proper project.

6.6.3.1 User application

Atmel G3-PLC firmware stack has been intended to hold the application code developed by the user.
So the user can integrate his application code in the firmware package delivered by Atmel. Basic
procedure for performing this integration (firmware configuration) is commented below. For more
information about the stack and integration procedure see the Atmel G3 Firmware Stack, doc43081.

Step 1 Use the right Atmel G3-PLC code version for frequency band to work.

G3 va.b.c_CENELEC folder is intended for ATPLCOUP007v2 board (CENELEC-A band), in case you
are going to use ATPLCOUP006v1 coupling board (FCC bands), you must use G3_va.b.c_FCC folder
to build the DLMS EMU projects with the correct configuration.

In case you want to use the boards’ kits, only this first step has to be taken into account
previous to download the firmware. Next steps can be omitted and load the project default
options in the boards.

Step 2 Configuring RTOS option.

As we commented previously in section 6.5.3 the user can choose between two different operation
modes:

e  Microcontroller operation mode.
e RTOS operation mode (using FreeRTOS).

The operation mode is defined in conf_oss.h file under the following define sentence:

/* 0S Support */
//#define 0SS_USE_FREERTOS

When OSS_USE_FREERTOS is defined then the FW is configured to work in RTOS
operation mode (FreeRTOS by default). Otherwise, when OSS_USE_FREERTOS is not
defined then the FW is executed in microcontroller operation mode.

If the user needs to change the RTOS configuration of his task (time period, priority...), he can modify
the corresponding variables in the header file oss_if.h.

Please take into account the requirements, handling and usage of the Atmel G3-PLC FW
Stack prior to changing the RTOS configuration.

Step 3 Initializing FW stack.

In order to start using the Atmel G3-PLC firmware stack, it is necessary to use the following function in
the main function after the hardware initialization:

void oss_init(void);

Step 4 Set user App function pointers.

OSS file is in charge of controlling all program flow.
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Step 5 Start execution.

oss_start function in microcontroller mode, this mode will be used to explain the different functions and
processes involved in program execution.

6.6.3.2 EUI64
Every device in a G3 network needs a unique EUI64 to be identified.
This EUI64 (or extended address) is stored in the variable CONF_EXTENDED_ADDRESS, which has
a default value, the same for every device, so a mechanism to ensure that different devices take different
EUI64s is required.
Mechanism to store expected sequence and EUI64 in flash memory is not provided, as it is expected to
be done when flashing the device.
For more information about EUI64 initialization see doc43081.
6.6.4 Running the PLC application example 4
For this example, the boards are plugged into the same power line. One board is the Coordinator and
the other one is the Device. Users have to execute an instance of the serial interface tool — which has
been previously installed to the host PC — in order to enable communication with Coordinator board.
For this example a serial interface tool is required. HyperTerminal is not installed on Windows 7. You can use
a PuTTY terminal instead. Once you have the serial terminal in your computer, open putty.exe and connect
to the COM port number assigned to the micro-B USB cable (see Figure 6-74). As is commented in section
3.5.5.3, UART 1 is available by USB connector J9. UART1 CMOS signals are also available in a triple row
male connector J16, see Figure 6-75. Remember to select the Standard COM Port, UART1.
Figure 6-74. COM Port selection.
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Set 921600 in the Speed field. In the Serial Category, change the Flow Control to None. The other fields
should already be correctly configured. Finally, click Open.
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Figure 6-75. PUTTY Configuration instance.
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In order to know if the boards were programmed successfully you can check the following:
o After that, green led D5, LEDO, is blinking. This indicates that the DLMS EMU application is
running on SAM4CP16C device.

e The LCD screen shows the following message: G3 COO for Coordinator board and G3 DEV for
Device board.

LCD message with DLMS EMU binary programmed for Coordinator, Figure 6-76, and for Device, Figure

6-77.

Figure 6-76. LCD message for Coordinator.

Figure 6-77. LCD message for Device.

In the Terminal window, main menu is displayed (press Reset button in case board has been supplied
previously to connect USB cable). Once coordinator board has been supplied after 4 minutes (time
defined in dims_emu_coord.h) it starts the cycle process. After this point, statics will appear on the

terminal.
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Figure 6-78. Coordinator terminal window, main menu.

EP COM265 - PuTTY

Figure 6-79. Coordinator terminal window, statics.
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[DLMS_EMU]
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[DLMS EMU]
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For more

doc43081.
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Cycle summary:

cycleId: 7 cycleTime: 743377470 ul_absolute_time: 20686053

node ID success errors availabiltyTimeCycle

node ID:

0x0001

Success:

14

Errors:

0 Availability: 100 TimerCycle: 8955

information about the DLMS Emulation procedure see the Atmel G3 Firmware Stack,
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Appendix A. Board schemes

A.1 SAMA4CP16CMBvV1 schemes
This section contains the schemes of the SAM4CP16CMB multipurpose board:

e Top level scheme.

e  Power supply scheme.

e SAMA4CP16C.

e  SAM4CP16C Power supply.

e PLC Coupling transmission scheme.

e PLC Coupling reception scheme.

e Peripherals.

e Interface.

e Components location in top and bottom layers.
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Figure A-1.

SAM4CP16CMB Top level scheme.

1 ‘ 2 3 4
Top Level '
op LEVEe )
Xplained PRO
U_Power Supply U_PLC Coupling Tx
Power Supply.Sc upling Tx.SchDoc
Tl MAI <= mP— e PLC+ PLC+ = RS485 '
2 PLC- PLC- RX [
2 N VZCROSS PLCTX
IV3EN
U_PLC Coupling Rx
U_SAMA4CPI6x PLC Coupling RxSchDoc __
SAMACPI =TT T
SAMA4CP16x PINOU PLCTX e JTAG
5| PAOSCOMI PO TDI A = ] PICRY B
PAL>COMI PBI > TDO PCI > UARTI RX VZCROSS
PA2> COM2 PB2 > TMS PC2 > SPI NPCSO SHDN
PA3 > COM3 > TCK PC3 > SPH MISO NRST
PA4 > XPLAINED PRO ADC PB4 -> UARTO RX PC4 > SPI MOSI PA0.31]
PA9 > USART2 RXMISO  PBS > UARTO TX PCS = SPI SPCK PB{0.31]
PAIO > USART2 TXMOST  PB6 == SEG24 PC6 = ARST Y]
PAIL > USARTI RX/SEGS  PB7 > SEG2S PCT > SRST TMPO
PAI2-> USARTI TX/SEG6  PBS -> SEG26 PCS > XPLAINED PRO SLP FWUP
PAI3 > USART2 SCK PBY > SEG2T PCY > ERASE U_Peripherals BN/MIMO
[PAI4 > USART2 RTS/CS PB10 ->SEG28 Peripherals.SchDac Interface
PAIS > SEGY PBI1 >VZ CROSS
PAI6 > SEG10 PBI2 > LDC ENABLE. U_SAMACPI6x Power
[PAI7 > USARTI RTS/SEG 11 PB13 -> SEG31 SAM4CP16x Power.SchDoc
PAIS > USARTI CTS/SEGI2 [PBI4 > USER LEDD et
PAI9 > USARTO RTS / SEGI3 PBIS > USER LEDI
PA20-> USARTO CTS/SEG14 PBI6 -> USARTO RX / SEG34
PA2I > SEGL PB17 > USARTO TX / SEG3S
PA22 > SEGI6 PBIS > SEG36
PAZ3 > SEGIT PBI9 >SEGIT
¢ > PB20 >SEGIS UARTS <
PA2S > TWCKO PB21 ->SEG39
PA26 > SEG20 PB22 >SEGA0
PA27 > SEG21 PB23 > 5V Sense
PAS > SEG22 PB24 >SEG42
PA29> LCD BACKLIGHT  PB25 >SEG43
PA30 > XOUT PB26 >SEGH4
PA31 > XIN/ CLKIN PB27 >SEG4S
PB28 >SEGA6 b
PB29 >SEGA7
PB31 > VDD sense
JUMPERS CONFIGURAT[ON Nl Initial I?cl‘r.\w 1171972014 AR
= = Rev Description Date Author
PAGE | DESIGNATOR DEFAULT FUNCTION -
F30Vac position T15/230Vac sel File date [ 11/20/2014 Sheet 1 of 8
D 119 Close Close to enabl Author | AR. Prq'ectl SAM4CP16xMB v1 b
0 Open (16V) Vdd 16/12V sclection
1 Close 3V3 force-on Verified | JL.C. File | Main.SchDoc
Z] Open Erase flash memory Cod =
B Close (3V3) Selection of VDDBU (3V3 or VBATT) D! FD2  FID}  FIDé PCB TITLE | Main s:r;:g:?;xma
1 ‘ 2 3 4
Figure A-2. SAM4CP16CMB Power supply scheme.
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Figure A-3. SAM4CP16C.
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Figure A-5. SAM4CP16CMB PLC Coupling Transmission scheme.
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Figure A-7.

SAM4CP16CMB Peripherals.
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Figure A-8. SAM4CP16CMB Interface.
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Figure A-9. SAM4CP16CMB components location in top layer.
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A.2 ATPLCOUPO007v2 schemes
This section contains the schemes of the ATPLCOUPO007 PLC Coupling board:

e PLC Coupling transmission scheme.
e Components location in top and bottom layers.

Atmel SAMACP16C-EK Kit User Manual [USER GUIDE] 99

Atmel-43086C-ATPL-SAM4CP16C-EK-Kit-User-Manual-UserGuide_23-Sep-2015



100

Figure A-11. ATPLCOUPO007 PLC Coupling Transmission scheme.
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ATMEL EVALUATION BOARD/KIT IMPORTANT NOTICE AND DISCLAIMER

This evaluation board/kit is intended for user's internal development and evaluation purposes only. It is
not a finished product and may not comply with technical or legal requirements that are applicable to
finished products, including, without limitation, directives or regulations relating to electromagnetic
compatibility, recycling (WEE), FCC, CE or UL. Atmel is providing this evaluation board/kit “AS IS”
without any warranties or indemnities. The user assumes all responsibility and liability for handling and
use of the evaluation board/kit including, without limitation, the responsibility to take any and all
appropriate precautions with regard to electrostatic discharge and other technical issues. User
indemnifies Atmel from any claim arising from user's handling or use of this evaluation board/kit. Except
for the limited purpose of internal development and evaluation as specified above, no license, express
or implied, by estoppel or otherwise, to any Atmel intellectual property right is granted hereunder.
ATMEL SHALL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES RELATING TO USE OF THIS EVALUATION BOARD/KIT.

ATMEL CORPORATION
1600 Technology Drive
San Jose, CA 95110
USA
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Revision History

Doc Rev. | Date Comments |

43086C 09/2015 | Updating EK contents (G3-PLC software version and boards).

43086B 03/2015 | Updating software projects.

43086A 02/2015 | Initial document release.
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